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Welcometo Exchange Reporter Plus

ManageEngine Exchange Reporter Plus is a web-based change audit and reporting
solution for MS Exchange, providing you a profound insight on your organization's

Exchange infrastructure.

Not plain reporting for vigilance, but this solution offers audit data, mail traffic statistics
& analysis, mailbox size growth rate, server usage pattern, and other important
information, using which an administrator can take informed decisions to optimize the
efficiency of his organization's Exchange setup. One look at these reports, an

administrator gets a clear picture of what he has to do next.

In other terms, Exchange Reporter Plus is an encapsulation of all the "analysis and
supervision” required on behalf of an Exchange administrator to manage his email

communication infrastructure efficiently!

Reports in ManageEngine Exchange Reporter Plus are distinguished into different
categories as listed below.

e Exchange Audit Reports

e Mailboxes Reports

e Outlook Web Access Reports
e Email Traffic Reports

e Storage Reports

e Distribution Lists Reports

e Public Folders Reports

e Organization Reports

This guide will help you understand, how to use ManageEngine Exchange Reporter Plus.

It provides information on :

e Hardware, Software and system requirements needed to install the application.
e Principle behind the working of Exchange Reporter Plus.

e Steps to get started.

< How to schedule data gatherings from various data sources.

e User management.

e Licensing.

e Other configurations required.

“\
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Contact ZOHO Corp.

e ZOHO Corp. Headquarters
e Sales

e Technical Support

ZOHO Corp. Headquarters

Web site www.zohocorp.com

ZOHO Corp. Headquarters ZOHO Corp. Inc.

4900 Hopyard Rd, Suite 310
Pleasanton, CA 94588 USA Phone:
+1-925-924-9500

Fax : +1-925-924-9600

E-mail: info@manageengine.com

ZOHO Development Center Zoho Corporation Private Limited

DLF IT Park, Block 7, Ground floor, No. 1/124,
Shivaji Garden, Nandambakkam Post,

Mount PH Road, Ramapuram,

Chennai 600 089, INDIA

Phone: +91-44-22707070
Fax: +91-44-22707172
Email: sales@manaaeenaine.com

Sales

To purchase ManageEngine Exchange Reporter Plus from any part of the world, send an
email to sales@manageengine.com.

You can also call the ZOHO Corp. headquarters at the following numbers:

Phone: +1-925-924-9500
Fax :+1-925-924-9600

Technical Support

One of the value propositions of ZOHO Corp. to its customers is excellent support.
During the evaluation phase the support program is extended to you free of charge.
Please send your technical queries to support@exchangereporterplus.com

Following is the support format to be enclosed, while sending support mails:

e Build Number of the product (Available at the top right corner of the "Support"
Tab in the product).

e Operating System version, such as Windows ME, Windows XP, Windows Vista,
Windows 7 etc.

e Browser version, such as Internet Explorer 6.0, Firefox 2.0, Google Chrome 1.0
etc.

e Details of the problem with screen-shots.
e Steps to reproduce the problem.


http://www.zohocorp.com/
mailto:info@manageengine.com
mailto:sales@manageengine.com
mailto:sales@manageengine.com
mailto:sales@manageengine.com
mailto:sales@manageengine.com
mailto:support@exchangereporterplus.com
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Alternatively, select the Support tab from the client window. It has the following options

that will allow you to reach us:
e Request Support - Submit your technical queries online.
 Need Features - Request for new features in Exchange Reporter Plus.

e Contact Us - Speak to our technical team using the toll free number (1-888-720-
9500)
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Getting Started

This section describes on how to get started with Exchange Reporter Plus.
e System Requirements
e Installing Exchange Reporter Plus
e How Exchange Reporter Plus works
< Working with Exchange Reporter Plus

e Licensing Exchange Reporter Plus
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SystemRequirements

e Hardware Requirements
e Software Requirements
e Supported Platforms

e Supported Browsers

Hardware Requirements:

e CPU: P4, 1.0 GHz
e RAM: 1GB

e Disk Space: 10 to 20 GB ( The storage space requirements might vary

depending upon your organization size, traffic frequency, Message Tracking Logs
and Outlook Web Access Log size.)

Software Requirements:

Exchange Reporter Plus needs MAPI to extract "mailbox size and content related data".

MAPI can be made available by installing any of the below.
e Exchange System Manager[ESM] 2003 SP2
e Microsoft Exchange Server MAPI Client and Collaboration Data Objects 1.2.1 (It
is downloadable from the link provided here :
http://www.microsoft.com/downloads/details.aspx?FamilylD=E17E7F31-079A-
43A9-BFF2-0A110307611E&displaylang=en).
[For Exchange 2010 environments only MAPI download option is supported.]

e Microsoft Outlook 2003 (or) 2007.

Supported Platforms

e Windows XP

e Windows 2003
e Windows 7

e Windows 2008

Supported Browsers

e Internet Explorer 6.0 and above

e Firefox 2.0 and above


http://www.microsoft.com/en-us/download/details.aspx?id=1004
http://www.microsoft.com/en-us/download/details.aspx?id=1004
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Installationof Exchange Reporter Plus

ManageEngine Exchange Reporter Plus can be installed on any MAPI installed machine in
the network.

To install ManageEngine Exchange Reporter Plus,
 Download the executable from the website
http://www.exchangereporterplus.com.
e Click on the Downloaded file "ManageEngine_ERP_windows.exe"
e Follow the install shield wizard to complete the installation of Exchange Reporter
Plus.

Adding an Exchange Organization

Once Exchange Reporter Plus is installed, an Exchange organization should be added to
proceed with the working.

Organization Settings

1 Please add an Exchange Organization to proceed.

Actions Organization Name Global Catalog Server User Name

Global Catalog Server !e_ljj_p-dcl 1.1]

Credentials

User Name © | 2 r
|xchange\administrator 18]

Password : eesesssssss ‘

Enter default credentials to be used for all the Gatherings:

Exchange Reporter Plus gathers information from the Exchange Server and other data
sources like Active Directory, Message Tracking Logs and Outlook Web Access Info (11S)
Logs. The credentials provided while adding an Exchange organization will be used as the
default credentials for all the data gatherings.


http://www.exchangereporterplus.com./
http://www.exchangereporterplus.com./
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Privileges Required for Data Gatherings:

Appropriate Credentials/Privileges to Gather Exchange Organization Information

Data To Be Gathered
Comprehensive data about
Exchange Organization and
Exchange Servers.

Privilege needed for Data Gathering \
Administrator credentials possessing appropriate
permissions (Including those given in the below
rows).

Mailbox Data

Exchange View only administrator who has 4
mailbox. The mailbox should not be hidden from the|
Global Address List(GAL).

Mailbox Content Data

Any valid user credential with "send as" and "receive
as" permissions on the mailboxes, about which
information is to be gathered

Exchange Traffic / Outlook Web
Access Info Log files

Any valid user credential with read access to the log
file on remote share

Public Folder Properties and Public
Folder Content Data

Any valid user credential with read access to Public
Folders, about which information is to be gathered
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HowExchange Reporter Plus works

Exchange related information is gathered from the Exchange Servers and other data
sources like Active Directory, Message Tracking Logs and Outlook Web Access Info (11S)
Logs. This data is gathered with the help of scheduled data gatherings configured in the
product. Scheduled gatherings are data extraction procedures, which require privileged
user credentials corresponding to the type of gatherings done. These privileges are
provided either when a new Exchange Organization is added or when a new scheduled

task is created.

Once these scheduled tasks are created (from the Admin Tab --> Task Scheduling
option), the product automatically collects the data at scheduled time intervals and

stores the data into an in-built postgresqgl database.

When a user selects a report in Exchange Reporter Plus, it queries the product database,

and provides tabulated and graphical representation of this data.
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Workingwith Exchange Reporter Plus

This topic discusses the following
1. Starting Exchange Reporter Plus
2. Accessing Exchange Reporter Plus

3. Stopping Exchange Reporter Plus

Starting Exchange Reporter Plus

To start Exchange Reporter Plus in console mode, click the Desktop Icon of Exchange

Reporter Plus from the machine where it is installed.

It can also be started from:

e Start -->> Programs -->>Exchange Reporter Plus -->> Start Exchange Reporter

Plus

Running Exchange Reporter Plus as a Service :

For Exchange Reporter Plus to be started as a service, install the "Exchange Reporter

Plus Service".

Installing "Exchange Reporter Plus Service"

Start -->>Programs -->> Exchange Reporter Plus -->> Service -->> Install

"Exchange Reporter Plus Service".

When you install "Exchange Reporter Plus Service" it will invoke the following User
Interface. Please provide the credentials of a user who has the administrative

privileges on the local machine where the product is installed.

ER| Exchange Reporter Plus Service Installation

The user name and password given will be used ko run this service

%]

ser Mame xchange’, administratar
Passward Aekckskokbokok
Install Cancel

Once the "Exchange Reporter Plus Service" is installed you can start the product as

"Windows service".
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When Exchange Reporter Plus is started in Windows XP / Windows 2003 machines with
firewall enabled, Windows may pop up security alerts asking whether to block or unblock
the following programs as shown in the images below:

1. mysqld-nt - Database server
2. Java(TM) 2 Platform Standard Edition binary - Java.

Unblock these programs to start Exchange Reporter Plus.

™= Windows Security Alert @

=) 10 help protect your computer, Windows Firewall has blocked
some features of this program.

Do you want to keep blocking this program?

=== Name: mysqld-nt
Publisher: Unknown

[ Keep Blocking ] [ Unblock ] [ Ask Me Later

Windows Firewall has blocked this program from accepting connections from the
Internet or a network. If you recognize the program or trust the publisher, you can
unblock it. When should | unblock a program?

Fig. MySQL Alert

= Windows Security Alert E]

_iﬂ? To help protect your computer, Windows Firewall haz blocked
zome features of this program.

Do you want to keep blocking this program?

Hame: Java[TM] Platform SE binary
3

= Puhblizher: Sun Microspsterns, [ne.

(=N

[ E.eep Blocking H_ Unblock, |[ Azk Me Later

Windows Firewall has blocked thiz program from accephng connections from the
Internet ar a nietwork, IF you recognize the program or tiuzt the publizher, you can
unblock it “when should | unblock a program?

Fig. Java Alert
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‘f-? The product does not run in service mode by default. It is recommended to
@ install in service mode for continuous data gathering.

Accessing Exchange Reporter Plus

To access the Exchange Reporter Plus open a Web browser and type
http://<hostname>:<port number> in the address bar.

Here the "hostname" refers to the DNS name of the machine where Exchange Reporter
Plus is running and the "port number" is the port at which Exchange Reporter is running.
The default port number is "8181" which can be changed during installation or from the
Connection settings of Exchange Reporter Plus.

‘*‘-? If the product runs in a console mode you can invoke the product client from
@ system tray icon as well.

h !

Stopping Exchange Reporter Plus

Start -->> Programs -->> Exchange Reporter Plus -->>Stop Exchange Reporter Plus.

"-? If the product runs in a console mode you can stop the product from system tray
@\ icon as well.
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Licensing of Exchange Reporter Plus

ManageEngine Exchange Reporter Plus license is based on the number of mailboxes. You
need to buy a license corresponding to the number of mailboxes in your Exchange
Organization. However, if you require data to be collected from specific mailboxes
present across the Exchange servers, you can selectively manage those mailboxes using
the manage / unmanage option in the product. Data is gathered for reporting only from
the mailboxes that are managed.

Trial License:

When you download and install the product, the product starts in a trial mode. This is
fully functional for 60 days. In the trial mode, data is gathered for reporting from your
entire Exchange Organization.

After the 60 days, the trial license expires and the software stops to fetch fresh data
from the Exchange Organization. However, reports on the previously fetched data can be
viewed and used.

Commercial Version:
You can anytime convert to the commercial version from the trial mode by applying a

valid ManageEngine Exchange Reporter Plus license. This license can be applied during
the trial period or even if the trial period has expired.
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Dashboard View

The Dashboard view under the Home tab, provides a quick snapshot on the most
important reports of Exchange Reporter Plus using bar graphs, Pie charts and tables.

Graphical representations of the following essential reports are shown.
e Server Storage Usage.

e Mailbox Size.
e Organization Traffic Summary.
e Top Server Traffic.

You can also use the Quick links located at the right of the page to access reports.
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Reports

In this section we will discuss about

Report Categories
Data shown in Reports

Reporting Features available in Exchange Reporter Plus

Report Categories:

Exchange Reporter Plus has a host of reports that provide complete information about
your Exchange Organization.

These reports are grouped into 7 different categories:

Organization Reports

Overall Organization Traffic Reports
Storage Reports

Server Traffic Reports

Mailboxes Reports

Mailbox Traffic Reports

Mailbox Content Reports

Mailbox Permission Reports

Custom Recipients Traffic Reports
Intra-Organization Traffic Reports
Overall Traffic From/To Internet Reports
Traffic From/To Internet By Domain Reports
Traffic From/To Internet By User Reports
Distribution Lists Reports

Distribution List Traffic Reports

Public Folders Reports

Public Folder Content Reports

Outlook Web Access Reports

Data shown in Reports:

The data shown in the reports, is extracted from various data sources and is based on
built-in data gathering tasks. Check the Reports based on Data Gatherings Table to
understand what type of Data Gathering task you are required to run, in-order to view
a report.


http://localhost:8182/help/reports/intra-organization-traffic-reports.html
http://localhost:8182/help/reports/overall-traffic-from-to-internet.html
http://localhost:8182/help/reports/traffic-from-to-internet-by-domain.html
http://localhost:8182/help/reports/traffic-from-to-internet-by-user.html

- =
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Reporting Features

The Reports provide several features to help administrators have an enhanced
experience while handling data.

e View reports in GMT or Local time zones.
e Option to Export the reports to CSV, PDF, XLS and HTML formats.

e Facilitates Printing of reports.

e Select and view reports for the Exchange Organization that you require
information.

e Reports can be viewed for selected date or period.
e Traffic details can be viewed in Summary, Daily or Hourly granular levels.
e Graphs and Charts that highlight the important aspects for a majority of reports.

e A "Quick Search" option allows you to search for specific data from a report by
providing one or multiple inputs.

« Determine the level of reporting using filters. For Example: "Mailbox Stores Growth
Report"” based on an "Administrative Group" and "Server".

e "Add/ Remove Columns" option allows you to include or exclude report columns.

e Option to select "number of records” that should be shown on a single page.
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Reports based on Data Gatherings

The below table will help you determine/understand what type of Data Gathering task

you are required to run, in-order to view reports of your choice.

Type of Data Gathering Reports

Essential data Gathering Task

Organization

Organization Summary
Administrative Groups
Routing Groups

Database Availability Groups
Servers

Storage Groups

Mailbox Stores

Mailbox Stores Growth
Public Stores

Public Stores Growth
Server Storage

Server Storage Growth
SMTP Virtual Servers
Connectors

Global Message Delivery
Settings

Mailbox Store Restrictions
Public Store Restrictions
Mail Enabled Users

Mail Enabled Contacts

Storage

Mailbox Stores

Mailbox Stores Growth
Public Stores

Public Stores Growth
Server Storage

Server Storage Growth

Mailboxes

Mailbox Enabled Users
Hidden Mailboxes

Mailbox Features

Mailbox Message Delivery
Settings

Mailbox Size Restrictions
Mailbox Message Restrictions
Mailbox with Delegates
Mailbox with Forward To

“\
/
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Type of Data Gathering Reports

Distribution Lists
e Distribution Lists

Public Folders
« Mail Enabled Public Folders

Distribution List Membership
Gathering Task

Distribution Lists
e Distribution List Members

Mailbox Account Properties
Gathering Task

Storage
e Mailbox Size
e Mailbox Size Growth

Mailboxes
e Mailbox Size
e Mailbox Size Growth
e Mailbox Size vs Allotted Size
e Orphaned Mailboxes

e Inactive mailboxes by lastlogon
time

Mailbox Content Gathering Task

Mailbox Content

e Folder Message Count and Size

e Messages By Subject Keyword

e Messages By Body Keyword

e Messages By Attachment File
Name Keyword

e Messages By Attachment File
Extension Keyword

e Messages By Attachment File
Size

Public Folder Properties Gathering
Task

Organization
e Organization Summary
 Servers

Storage
e Public Folder Size

Public Folders
e Public Folder List
e Public Folder Replicas
e Public Folder Size

Public Folder Content Gathering
Task

Public Folder Content

e Messages By Subject Keyword

e Messages By Body Keyword

e Attachments By File Name
Keyword

e Attachments By File Extension
Keyword

e Attachments By File Size

Traffic Logs Gathering
Task

Organization Traffic
e Organization Traffic Summary
e Sent Traffic By Messages
e Sent Traffic By Size
e Received Traffic By Messages
e Received Traffic By Size
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Type of Data Gathering Reports

Server to Server Traffic
e Delivery Times by Server
e Number of Messages Sent by

Server

e Size of Messages Sent by
Server

e Number of Messages Received
by Server

e Size of Messages Received by

Server

Intra-Organization Traffic
e Mails Exchanged Between Users
e Number of Mails Sent By Users
e Size of Mails Sent By Users

e Number of Mails Received By
Users

e Size of Mails Received By Users

e Traffic Between Two Specific
Users

Overall Traffic from/to Internet

e Number of Mails Sent to
Internet

e Size of Mails Sent to Internet

e Number of Mails Received from
Internet

e Size of Mails Received from
Internet

Traffic from/to Internet (By
Domain)

e Number of Mails Sent to a
Specific Domain

e Size of Mails Sent to a Specific
Domain

e Number of Mails Received from
a Specific Domain

e Size of Mails Received from a
Specific Domain

Traffic from/to Internet (By User)
e Number of Mails Sent by Users
e Size of Mails Sent by Users

< Number of Mails Received by
Users

e Size of Mails Received by Users
e Number of Mails Sent to a
Specific Domain By A Given User

e Number of Mails Received from
a Specific Domain By A Given User




Mailbox Traffic
e Number of Messages By Sender
e Size of Messages By Sender
e Number of Messages By
Receiver
e Size of Messages By Receiver

Custom Recipient Traffic
e Custom Recipients by Message
e Custom Recipients by Size
e Users of Custom Recipients by

Message
e Users of Custom Recipients by
Size

Distribution List Traffic
e Distribution Lists by Message
e Distribution Lists by size
e Users of Distribution Lists by
Message

e Users of Distribution Lists by
size

Mailbox
e Inactive Mailboxes By Last Sent
Mail

Distribution Lists
 Inactive Distribution Lists

Mailbox Permissions Gathering
Task

Mailbox Permissions
e Permissions based on Mailboxes
e Permissions based on Users

Outlook Web Access Info Log
Gathering Task

Department Reports
e Log on Count per Department
e Log on Count for Users of a
Department
e Log on Specifics for Users of a
Department

Outlook Web Access
e Log on By Users
e Browser based Log on
e Client IP based Log on
e Server based Log on
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OrganizationReports

This category provides reports on the top level objects in the Exchange Organization.
You can get an insight into the statistics, limitations, growth rates of these objects.

This report is based on Essential data gathering task and can be manually scheduled
from the task scheduling option.

The reports under this category are:
e Organization Summary
e Administrative Groups
e Routing Groups
e Database Availability Groups
e Servers
e Storage Groups
e Mailbox Stores
e Mailbox Stores Growth
e Public Stores
e Public Stores Growth
e Server Storage
e Server Storage Growth
e SMTP Virtual Servers
e Connectors
e Global Message Delivery Settings
e Mailbox Store Restrictions
e Public Store Restrictions
e Mail Enabled Users

e Mail Enabled Contacts

Organization Summary Report:

This report provides data on the number of Administrative Groups, Routing Groups,
Servers, Storage Groups, Mailbox Stores, Public Stores, Mailboxes, Distribution Groups,
Public Folders present in the selected Exchange Organization.

To view Organization Summary Report:
e Click on "Reports" -->>"0Organization"-->>0rganization Summary Report

Objects in the selected Exchange Organization, you can view the complete
information of that object in a separate report. For example: Clicking on the
statistic available under the "Administrative Groups" column will show
"Administrative Groups Report".

[ﬁ? On clicking on the reported summary data (statistic) shown for various Exchange
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Administrative Groups Report:

Administrative groups, allow you to designate administrative control over subsets of your
Exchange organization. The Administrative Groups report lists all administrative groups
available in a selected Exchange Organization. It also lists the number of Routing Groups
and Servers available under Each Administrative Group.

To view Administrative Groups Report:

1. Click on the "Reports" -->> "Organization" -->> Administrative Group.

Routing Groups Report:

This report lists all "Routing Groups" in your Exchange Organization. It provides data on
the number of servers available under each routing group.

To view Routing Groups Report:

1. Click on the "Reports" -->> "Organization" -->> Routing Groups.
Database Availability Groups Report:

This report is for organizations that have Exchange 2010 Servers. It lists all "Database
Availability Groups" in an selected Exchange Organization. Data on the number of
servers within each Database Availability Group is shown.

To view Database Availability Groups Report:

1. Click on the "Reports" -->> "Organization™ -->> Database Availability Groups.

Servers Report:

This report list all the Servers in a selected Exchange Organization. Information related
to a server that include Server Name, Server Version, Server Role, Number of Mailbox

Stores, Number of Public Stores, Number of Mailboxes and Number of Public Folders is

shown.

To view Servers Report:

1. Click on the "Reports" -->> "Organization" -->> Servers.

Storage Groups Report:

This report lists all the Storage Groups in a selected Exchange Organization. It also lists
the Number of Mailbox Stores and Number of Public Stores available under each Storage
Group.

To view Storage Groups Report:
1. Click on the "Reports"-->>"0Organization" -->> Storage Groups.

Mailbox Stores Report:

This report lists all the Mailbox Stores present in a selected Exchange Organization. It
also lists the Store size and number of mailboxes present in each mailbox store.

To view Mailbox Stores Report:
1. Click on the "Reports" -->>"Organization" -->>"Mailbox Stores".
2. Select a "Date"

A graphical comparison of various Mailbox Stores based on their size is provided.
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Mailbox Stores Growth Report:

This report shows the Initial Store Size, Final Store Size and Growth Rate of all the
Mailbox Stores in an Exchange Organization for any selected period.

To view Mailbox Stores Growth Report:

1. Click on the "Reports" -->>"Organization" -->>"Mailbox Stores Growth".

Mailbox Stores Growth for the selected period is also graphically represented for easy
understanding.

Public Stores Report:

This report lists all the public stores in a selected Exchange Organization . It also lists the
Store size and number of Public Folders present in each Public Store.

To view Public Stores Report:
1. Click on the "Reports" -->> "Organization™ -->>"Public Stores".
2. Select a Date from the Date option

A graphical comparison of various Public Stores based on their size is provided.

Public Stores Growth Report:

This report shows the Initial Store Size, Final Store Size and Growth Rate of all Public
Stores in an Exchange Organization for any selected period.

To view Public Stores Growth Report:
1. Click on the "Reports" -->>"Organization" -->>"Public Stores Growth".
2. Select a Period .

Public Stores Growth for the selected period is graphically represented for easy
understanding.

Server Storage Report:

This report provides storage information about the Server like Total Server Volume,
Volume used and Volume Used by stores. Further percentage of usage is also provided in
this report.

To view Server Storage Report:
1. Click on the "Reports" -->>"Organization" -->>"Server Storage"
2. Select a Period .

A graphical representation of various servers and the Total Server Volume, Volume used
by Stores, Volume Used by others and Free Space available in each server is shown.

Server Storage Growth Report:
This report includes two sub-reports:

1. Store Size Growth

2. Server Volume Growth
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Store Size Growth

Store Size Growth report shows the Initial Store Size, Final Store Size and Growth Rate
of all stores in an Exchange Server for any selected period.

To view Store Size Growth:

1. Click on the "Reports" -->> "Organization" -->>"Server Storage Growth"--
>>"Store Size Growth"

2. Select a Period .

Store Size Growth for the selected period is graphically represented for easy
understanding.

Server Volume Growth

Server Volume Growth shows the Initial Server Volume, Final Sever Volume and Growth
Rate of all Exchange Servers in an Exchange Organization for any selected period.

To view Server Volume Growth:

1. Click on the "Reports" -->> "Organization" -->>"Server Storage Growth" --
>>"Server Volume Growth"

2. Select a Period .

Server Volume Growth for the selected period is graphically represented for easy
understanding.

SMTP Virtual Servers Report:

This report lists all SMTP Virtual Servers in any selected Exchange Organization.
Information on the Servers, Administrative Groups for each of the SMTP Virtual Servers
is shown.

To view SMTP Virtual Servers Report:

1. Click on the "Reports" -->>"0Organization" -->>"SMTP Virtual Servers".

Connectors Report:

This report lists all "Connectors" available in a selected Exchange Organization. This lists
all connectors and their corresponding types in the selected Exchange Organization.

To view connectors report:

1. Click on the "Reports" -->>"Organization" -->>"Connectors".

Global Message Delivery Settings Report:

This report provides data on the Global Message Delivery Settings in any selected
Exchange Organization. The Maximum Message Sending Size(MB), Maximum message
Receiving Size(MB) and the Recipient Limit configured for Message Delivery in the
Exchange Organization selected is shown.

To view a Global Message Delivery Settings report:

1. Click on the "Reports" -->> "Organization" -->> "Global Message Delivery
Settings".
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Mailbox Store Restrictions Report:

This report lists the size restrictions for all Mailbox Stores in a selected Exchange
Organization. The following size restrictions will be set for all mailbox stores:

e Issue warning.
e Prohibit Sending of mails.

e Prohibit Sending and Receiving of mails.
To view Mailbox Stores Restrictions report:
1. Click on the "Reports" -->> "Organization" -->> "Mailbox Store Restrictions".

Public Store Restrictions Report

This report lists the size restrictions for all Public Stores in a selected Exchange
Organization. The following size restrictions will be set for all mailbox stores:

e Issue warning.
e Prohibit Sending of mails.

e Prohibit Sending and Receiving of mails.

To view Public Stores Restrictions Report:
1. Click on the "Reports" -->> "Organization" -->>>"Public Store Restrictions".

Mail Enabled Users Report

This report lists all mail enabled users in an Exchange Organization and their
corresponding external email addresses.

To view Mail Enabled Users Report:
1. Click on the "Reports" -->> "Organization" -->>"Mail Enabled Users".

Mail Enabled Contacts Report

Mail Enabled Contacts are entries made in active directory that link to email addresses
that are outside of your organization. These contacts will appear in the Global Address
List, allowing users to select them and send email messages to them.. Their primary use
is for forwarding email from an existing mailbox.

This report lists all mail enabled contacts in a selected Exchange Organization.

To view Mail Enabled Contacts Report:
1. Click on the "Reports" -->> "Organization"-->>"Mail Enabled Contacts".
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Overall Organization Traffic Reports

This category provides reports on organization traffic. The summary and also details of
the number of messages and Size of messages that are sent and received.

The reports under this category depend on "Message Tracking Logs Gathering Task".

Y levels. Hourly granular level can be selected only when the time period
selected is less than 2 days.
If the report is at daily granular level, you can view the hourly report for a
|date by clicking on the date displayed in the report.

@\— e The reports can be viewed at summary or daily or hourly granular

The list of Organization Traffic Reports are:
e Organization Traffic Summary
e Sent Traffic By Messages
e Sent Traffic By Size
e Received Traffic By Messages

e Received Traffic By Size

Organization Traffic Summary Report:

This report provides the complete summary of message traffic in an Exchange
Organization. Statistics on the total number of messages sent and received, and the
total Size of messages sent and received is shown.

To view Organization Traffic Summary Report:

1. Click on "Reports" -->> "Organization Traffic"-->>"Organization Traffic
Summary"

2. Select the Period

This provides 4 different tables and 2 Pie charts that provide the summary of
Organization Traffic.

Table 1 provides the min, max and average of the number of messages sent
and received.

Table 2 provides the min, max and average of the size of messages sent and received.

more than 2 days. If the time period is <= 2 days then the min, max and

* |average will be calculated per hour.

@k? The min, max and average will be calculated per day if the period selected is

Table 3 provides traffic summary of sent mails
e Total Number of Mails sent,

e Total Number of Mails Sent internally
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Total Number of Mails Sent to an external recipient

Total Size of Mails Sent

Total Size of Mails Sent internally

Total Size of Mails Sent external recipient.

Table 4 provides traffic summary of received mails
e Total Number of Mails received,

Total Number of Mails received from an internal source.

Total Number of Mails received from an external source.

Total Size of Mails received

Total Size of Mails received from an internal source.

Total Size of Mails received from an external source.

Pie Chart 1 provides snapshot of Total Number of Messages Sent and Total Number of
messages received.

Pie Chart 2 provides snapshot of Total Size of Messages Sent and Total Size of
messages received.

Sent Traffic By Messages Report:

This report provides the minimum, maximum and average Number of Messages sent
internally and number of messages sent to an external recipient.

To view Sent Traffic By Messages Report:
1. Click on "Reports" -->> "Organization Traffic"-->>"Sent Traffic By Messages"
2. Select the Period
3. Select the Granularity (Summary, Daily or Hourly)
4. Click on Go

Depending on the time period selected, the type of graph displayed changes. We have
two different types of graphs:

e Pie Chart - A Pie chart is displayed for summary granular level. This is the graph
that is displayed by default when the report is selected initially. The Pie chart
shows the distribution of the "number of internal messages sent” and "number of
external messages sent".

e Line Graph - Line graph is displayed for daily and hourly granular levels. The line
graph displays the "number of internal messages sent" and "number of external
messages sent" every hour/ every day.

Sent Traffic By Size Report:

This report provides the minimum, maximum and average Size of Messages sent
internally and Size of messages sent to external recipients.

To view Sent Traffic By Size Report:
1. Click on "Reports" -->=> "Organization Traffic"-->>"Sent Traffic By Size"
2. Select the Period



-y

Q‘ ManageEngine Exchange Reporter Plus :: Help Documentation

—

3. Select the Granularity (Summary, Daily or Hourly)
4. Click on Go

Depending on the time period selected, the type of graph displayed changes. We have
two different types of graphs:

e Pie Chart - A Pie chart is displayed for summary granular level. This is the graph
that is displayed by default when the report is selected initially. The Pie chart
shows the distribution of the "size of internal messages sent” and "size of
external messages sent".

e Line Graph - Line graph is displayed for daily and hourly granular levels. The line
graph displays the "size of internal messages sent" and "size of external
messages sent" every hour/ every day.

Received Traffic By Messages Report:

This report provides the minimum, maximum and average Number of Messages received
from internal and external sources.

To view Received Traffic By Messages Report:
1. Click on "Reports" -->=> "Organization Traffic"-->>"Received Traffic By Messages"
2. Select the Period
3. Select the Granularity (Summary, Daily or Hourly)
4. Click on Go

Depending on the time period selected, the type of graph displayed changes. We have
two different types of graphs:

e Pie Chart - A Pie chart is displayed for summary granular level. This is the graph
that is displayed by default when the report is selected initially. The Pie chart
shows the distribution of the "number of internal messages sent" and "number of
external messages sent".

e Line Graph - Line graph is displayed for daily and hourly granular levels. The line
graph displays the "number of internal messages sent" and "number of external
messages sent" every hour/ every day.

Received Traffic By Size Report:

This report provides the minimum, maximum and average size of Messages received
from internal and external sources.

To view Size Traffic By Messages Report:
1. Click on "Reports" -->> "Organization Traffic"-->>"Received Traffic By Size"
2. Select the Period.
3. Select the Granularity (Summary, Daily or Hourly)
4. Click on Go.
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Depending on the time period selected, the type of graph displayed changes. We have
two different types of graphs:

e Pie Chart - A Pie chart is displayed for summary granular level. This is the graph,
that is displayed by default when the report is selected initially. The Pie chart
shows the distribution of the "size of internal messages sent” and "size of
external messages sent".

e Line Graph - Line graph is displayed for daily and hourly granular levels. The line
graph displays the "size of internal messages sent" and "size of external
messages sent" every hour/ every day.
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StorageReports

This category provide reports on the store size of various Exchange objects and storage
growth for a selected period.

Storage Reports under this category are:
e Mailbox Stores
e Mailbox Stores Growth
e Mailbox Stores Split-Up
e Public Stores
e Public Stores Growth
e Server Storage
e Server Storage Growth
e Mailbox Size
e Mailbox Size Growth
e Public Folder Size

Mailbox Stores Report:
This report lists all Mailbox Stores in an Exchange Server on any selected Date. It is
based on Essential Data Gathering Task.

To view Mailbox Stores report
1. Click on Reports -->>Storage -->>"Mailbox Stores"
2. Select the Date for which Mailbox Store Data is required.

A "Mailbox Store Size Comparison" bar chart allows comparison of Mailbox Stores with
ease.

Mailbox Stores Growth Report:

This report shows the Initial Store Size, Final Store Size and Growth Rate of all the
Mailbox Stores in an Exchange Organization for any selected period. It is based on
Essential Data Gathering Task.

To view Mailbox Stores Growth Report:

e Click on the "Reports" -->>"Storage" -->>"Mailbox Stores Growth".

Mailbox Stores Growth for the selected period is also graphically represented for easy
understanding.

Mailbox Stores Split-Up Report:

This report shows the percentage of a mailbox store volume consumed by the mailboxes,
the total store size and the number of mailboxes in the store. It is based on Mailbox
Account Properties Gathering Task.

To view Mailbox Stores Split-Up Report:
< Click on the "Reports" -->>"Storage" -->>"Mailbox Stores Split-Up".

= Select the period.
The mailbox store split-up is shown graphically.

Note : This report shows the storage space used by managed mailboxes alone. To view
the size used by all mailboxes in a server, manage all mailboxes on the server and run
Mailbox Account Properties task.
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Public Stores Report:

This report provides information on the public stores Storage Group and Store Size. The
Public Store name and its related information. This report is based on Essential Data
Gathering Task.

To view Public Stores Report:
1. Click on Reports -->> Storage -->=> "Public Stores"

2. Select the "Date" for which Public Store information is to be viewed.

Public Store Size Comparison Bar chart allows easy comparison on the sizes of Public
Stores on a given date.

Public Stores Growth Report:

This report shows the Initial Store Size, Final Store Size and Growth Rate of all Public
Stores in an Exchange Organization for any selected period. It is based on Essential
Data Gathering Task.

To view Public Stores Growth Report:
1. Click on the "Reports" -->>"0Organization" -->>"Public Stores Growth".
2. Select a Period .

Public Stores Growth for the selected period is graphically represented for easy
understanding.

Server Storage Report:

This report provides storage information about the Server like Total Server Volume,
Volume used and Volume Used by stores. Further percentage of usage is also provided in
this report.

To view Server Storage Report:
1. Click on the "Reports" -->>"Storage" -->>"Server Storage"
2. Select a Period .

A graphical representation of various servers and the Total Server Volume, Volume used
by Stores, Volume Used by others and Free Space available in each server is shown.

Server Storage Growth Report:

This report provides storage information about the Server like Total Server Volume,
Volume used and Volume Used by stores. Further percentage of usage is also provided in
this report. This report is based on Essential Data Gathering Task.

To view Server Storage Report:
1. Click on the "Reports" -->>"0Organization" -->>"Server Storage"
2. Select a Period .

The Server Storage Growth is graphically represented for easier understanding.

Mailbox Size Report:

The report lists the mailbox sizes for mailboxes in a selected organization for a selected
period. It is based on Mailbox Account Properties Gathering Task

To view Mailbox Size Report:
1. Click on Reports -->> Storage -->> "Mailbox Size"

2. Select the Period.

Top 10 Mailboxes by Size for the selected period is shown using a Bar chart.
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Mailbox Size Growth Report:

This report shows the initial, final size of mailboxes and their Growth Rates. It is based
on Mailbox Account Properties Gathering Task.

To view Mailbox Size Growth Report
1. Click on "Reports" -->> "Storage" -->>"Mailbox Size Growth"

2. Select the "Period"

The Top 5 Mailboxes Growth for the selected period is shown as a line graph. Different
points in the graph highlight growth at different days in a week.

Public Folder Size Report:

This report lists public and provides information on the Number of messages in the Public
Folder and Public Folder Path for all Public Folders. It is based on Public Folder Properties
Gathering Task.

To view a Public Folder Size Report
1. Click on Reports -->> Storage -->> "Public Folder Size"

2. Select the "Period".

The Top 10 Public Folders, arranged by size of Public Folders are shown as a graphical
representation using Bar charts.
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Server Traffic Reports

This category provides reports on message delivery times and message traffic between
exchange servers.

The reports in this category depend on Message Tracking Logs Gathering Task.

Hourly granular level can be selected only when the time period selected
is less than 2 days.
* If the report is at daily granular level, you can view the hourly report for
a date by clicking on the date displayed in the report.

@? e The reports can be viewed at summary or daily or hourly granular levels.

The List of Server Traffic Reports category are:
e Server to Server Traffic
e Delivery Times by Server
e Number of Messages Sent by Server
e Size of Messages Sent by Server
< Number of Messages Received by Server

e Size of Messages Received by Server

Server to Server Traffic Report:

This report provides complete information for message traffic between the exchange
servers in an organization.

To view Server to Server Traffic report:
1. Click on Reports -->> Server Traffic -->>"Server to Server"

2. Select the Period.
3. Select the Granularity. (Summary, Daily or Hourly).

Delivery Times by Server Report:

Delivery Times by Server report lists minimum, maximum and average message delivery
times between the exchange servers in an organization.

To view Delivery Times by Server Report:
1. Click on Reports --=>> Server Traffic -->> "Delivery Times by Server"
2. Select the Period.
3. Select the Granularity (Summary or Daily)

time on the client machines, from which the message have been sent, is

" |synchronized with the exchange servers.

[ﬂ? The delivery times for this report are calculated under the assumption that the
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Number of Messages Sent by Server Report:

This report provides the information on the internal/external number of messages sent
from exchange servers.

To view Number of Messages Sent by Server Report:
1. Click on Reports -->> Server Traffic -->> "Number of Messages Sent by Server"
2. Select the Period.
3. Select the Granularity (Summary or Daily)

Depending on the time period selected the graph displayed in the report changes. We
have two different types of graphs:

e Bar graph - Bar chart is displayed for summary granular level. This is the graph
that is displayed by default when the report is selected initially. The bar chart
displays the top 10 servers by number of messages sent.

e Line Graph - Line graph is displayed for daily and hourly granular levels. The line
graph displayed only the top 5 servers by number of messages sent.

Size of Messages Sent by Server Report:

This report provides the information on the internal/external size of messages that are
sent from exchange servers.

To view Size of Messages Sent by Server Report:
1. Click on Reports -->> Server Traffic -->> "Size of Messages Sent by Server"
2. Select the "Period".
3. Select the Granularity (Summary, Daily or Hourly)

Depending on the time period selected the graph displayed in the report changes. We
have two different types of graphs:

e Bar graph - Bar chart is displayed for summary granular level. This is the graph
that is displayed by default when the report is selected initially. The bar chart
displays the top 10 servers by size of messages sent.

e Line Graph - Line graph is displayed for daily and hourly granular levels. The line
graph displayed only the top 5 servers by size of messages sent.

Number of Messages Received by Server Report:

The report provides the information on the internal/external number of Messages that
are received by the exchange.

To view Number of Messages Received by Server Report:

1. Click on Reports -->> Server Traffic -->> "Number of Messages Received by
Server”

2. Select the "Period".

3. Select the Granularity (Summary, Daily or Hourly)
Depending on the time period selected the graph displayed in the report changes. We
have two different types of graphs:
e Bar graph - Bar chart is displayed for summary granular level. This is the graph
that is displayed by default when the report is selected initially. The bar chart
displays the top 10 servers by number of messages received.
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e Line Graph - Line graph is displayed for daily and hourly granular levels. The line
graph displayed only the top 5 servers by number of messages received.

Size of Messages Received by Server

The report provides the information on the Size of Messages that are received by the
exchange servers.

To view Size of Messages Received by Server Report:
1. Click on Reports -->> Server Traffic -->>"Size of Messages Received by Server"
2. Select the "Period".
3. Select the Granularity (Summary, Daily or Hourly)

Depending on the time period selected the graph displayed in the report changes. We
have two different types of graphs:

e Bar graph - Bar chart is displayed for summary granular level. This is the graph

that is displayed by default when the report is selected initially. The bar chart
displays the top 10 servers by size of messages received.

e Line Graph - Line graph is displayed for daily and hourly granular levels. The line
graph displayed only the top 5 servers by size of messages received.
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Mailboxes Reports

This category provides reports on the Mailboxes in your Exchange Organization.
Information related to a mailbox, mailbox settings, delivery restrictions and any activity
that is concerned with mailboxes is reported.

The List of Mailbox Reports are:
e Mailbox Enabled Users
e Mailbox Size
e Mailbox Size Growth
e Current Mailbox Size VS Quota
e Hidden Mailboxes
e Inactive Mailboxes By Last Sent Mail
e Inactive Mailboxes by Last logon time
e Orphaned Mailboxes
e Expired Account Mailboxes
e Soon-to-Expire Account Mailboxes
e Mailbox Features
 Mailbox Message Delivery Settings
e Mailbox Size Restrictions
e Mailbox Message Restrictions
< Mailbox with Delegates

e Mailbox with Forward To

Mailbox Enabled Users Report:

This report lists all Mailbox Enabled Users. The Mailbox Name, Email, Last Logon User,
Last Logon Time and Server information are listed.

To view Mailbox Enabled Users report:

e Click on Reports --=>>Mailboxes -->>Mailbox Enabled Users
Mailbox Size Report:

This report lists all Mailboxes in an Exchange Organization and their size, count
information on any selected day or the maximum size, count for a selected period.

To view a Mailbox Size report:
1. Click on Reports -->> Mailboxes -->> Mailbox Size

2. Select the day, date or period.
Selecting Mailbox Size for more than one day displays the maximum size attained in the

selected week. The date at which each mailbox was largest in the selected period is also
listed.

Top 10 Mailboxes by Size are displayed on a Bar Graph. Click on any of the Bars to view
Mailbox specific information.


http://localhost:8182/help/reports/mailbox-reports.html#inactivemailboxesbylastlogontime
http://localhost:8182/help/reports/mailbox-reports.html#expiredaccount
http://localhost:8182/help/reports/mailbox-reports.html#soontoexpire
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Mailbox Size Growth Report:

This report provides information on the Growth of all Mailboxes in the selected Exchange
Organization for the Period Selected. This report lists the mailboxes, their initial and final
size and corresponding Growth Rates, on a single report.

To view Mailbox Size Growth report:
1. Click on Reports --=>> Mailboxes -->> "Mailbox Size Growth"

2. Select the "Period" from Drop Down. (Any custom period day, date or period can
be selected).

The Top 5 Mailboxes Growth in the selected period can also be viewed. Different points
in the graph highlight growth at different days in a week.

This report cannot be viewed daily because Mailbox Size is collected only once in a day.

Current Mailbox Size VS Quota

This report lists the current sizes of mailboxes in an Exchange Organization. It also
compares the Percentage of Current Usage of a Mailbox to its Quota allotted. Users can
compare the Current Mailbox Sizes as a percentage of any of the following parameters
whose quotas are set.

e Issue Warning At
e Prohibit Send At
e Prohibit Send and Receive At
To view Current Mailbox Size vs Quota report:
e Click on Reports -->> Mailboxes -->> "Current Mailbox Size vs Quota"
e Select the Comparison Parameter.

Top 10 Mailboxes based on Percentage of Size Used are displayed using a Bar chart.

Hidden Mailboxes Report:

This report lists all mailboxes that are hidden. The mailbox name and their
corresponding emails are reported.

To view Hidden Mailboxes report:

e Click on Reports -->> Mailboxes -->> "Hidden Mailboxes"

Inactive Mailboxes By Last Sent Mail Report:

This report lists all Inactive Mailboxes in the Exchange Organization. Any Mailbox that
did not have an outward traffic for the past 35 days is considered to be inactive by
Exchange Reporter Plus. Mailbox Names, the associated email and the date on which the
last email was sent is reported.

To view Inactive Mailboxes by Last Sent Email report:
e Click on Reports -->> Mailboxes -->> "Inactive Mailboxes by Last Sent Mail"
e Input the "Inactive period" in the textbox provided.
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Inactive Mailboxes By Last Logon Time Report

This report lists all Inactive Mailboxes in the Exchange Organization. This report is based
on the last logon time of a user. Any Mailbox that was not logon in the inputted number
of days is considered to be inactive by Exchange Reporter Plus. Mailbox Names, the
associated email and the date on which the last email was sent is reported.

To view Inactive Mailboxes by Last Sent Email report
e Click on Reports -->> Mailboxes -->> "Inactive Mailboxes by Last Logon Time"
e Input the "Inactive period" in the textbox provided.

Orphaned Mailboxes Report:

Accidental deletion of a user account from the Active Directory database could leave one
or more mailboxes Orphaned. Exchange Reporter Plus lists all "Orphaned Mailboxes" in a
selected Exchange Organization with the help Orphaned Mailboxes reports.

This report provides information the "Mailbox Name", "Last Logon User", "Last Logon
Time", "Number of Messages" and the "Size" of all Orphaned Mailboxes in the selected
Exchange Organization.

To view Orphaned Mailboxes report:
e Click on Reports -->> Mailboxes -->> "Orphaned Mailboxes"

Expired Account Mailboxes Report:

This report list Mailboxes of Expired Accounts. Mailboxes for Accounts that were expired in
the inputted number of days will be listed.
To view Expired Accounts Mailboxes report

e Click on Reports -->> Mailboxes -->> "Expired Account Mailboxes"
e Select Account Expired time from the dropdown.

This will list all expired accounts in the selected period and the mailboxes associated with
those accounts.

Soon-to-expire Account Mailboxes Report:

This report lists mailboxes of Accounts that are soon-to-expire. Accounts that will be
expired within the selected period of time will be listed.
To view Soon-to-expire Account Mailboxes

e Click on Reports -->> Mailboxes -->> "Soon-to-expire Mailboxes"
e Select the time of Account Expiry from the drop down

This will list the soon-to-expire accounts and the mailboxes associated with those
accounts.

Mailbox Features Report:

Mailbox Features include Outlook Web Access (OWA), Outlook Message Access (OMA),
Post Office Protocol (POP3) and IMAP4. The status on the availability or unavailability of
these features for each of the mailboxes for any selected Exchange Organization are
displayed in this report.
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To view Mailbox Features report:
1. Click on Reports -->> Mailboxes -->> "Mailbox Features"

2. This lists all mailboxes in the Exchange Organization that have all the features
enabled.

3. To view filtered information of enabled or disabled status of (OWA, OMA, POP3
and IMAP4) on mailboxes in the Exchange Organization choose any of the options
listed under the "Mailbox Feature" Drop Down.

Mailbox Message Delivery Settings Report:

This report lists all mailboxes in a selected Exchange Organization and provides
information on the type of message delivery settings they have:

The report lists information on the

 Mailboxes that have Default Message Delivery Settings (Default Sending Size,
Default Receiving Size and Default Recipient Limit ) and

 Mailboxes that have Restricted Message Delivery Settings (Restricted Sending
Size, Restricted Receiving Size and Restricted Recipient Limit).

To view Mailbox Message Delivery Settings report:
1. Click on Reports -->> Mailboxes -->> "Mailbox Features"

2. This lists all mailboxes and the complete list of delivery settings that each of the
mailboxes have.

3. To view filtered information on mailboxes with "Default Sending Size" -
4. Select the option available under the "Message Delivery Setting" drop down.

Similarly select any desired "Message Delivery Setting" available under the drop down to
view filtered information.

Mailbox Size Restrictions Report:

This report lists the "Default Storage limit" and various actions that will be performed
when a Mailbox reaches set Size limits. This report provides the limits set for every
mailbox in the selected Exchange Organization to

e Issue a Warning (KB)

e Prohibit Send (KB)

e Prohibit Send and Receive (KB) Messages.
To view mailbox size restrictions report:

1. Click on Reports -->> Mailboxes -->> "Mailbox Size Restrictions"

2. This lists the size restrictions for all mailboxes in the Exchange Organization.

3. You can view Size Restrictions for Mailboxes based on the allotted size by
selecting from the "Size Restriction Drop Down" Mailboxes allotted Default
storage limit or Mailbox allotted user specified storage limits.

Mailbox Message Restrictions Report:

This report lists the complete information on the Message Settings that are assigned to
users that allow / deny them from accepting mails. It allows select and view Message
Settings of users from a dropdown that allow them to view settings of users that allow
them to

e Accept Messages from Authenticated Users only.

 Accept Messages from Un-authenticated Users Also.

—
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e Accept Messages from Everyone.
e Accept Messages only from.

e Accept Messages from Everyone Except.

To view Mailbox Message Restrictions set for users report:
1. Click on Reports -->> Mailboxes -->> Mailbox Message Restrictions

2. Select the "Message Settings" for which status of users is to be viewed from the
dropdown

Mailbox with Delegates Report:

This report lists all mailboxes in an Exchange Organization that are delegated to "send
on behalf".

To view the list of Mailboxes with Delegates report:
e Click on Reports -->> Mailboxes -->> Mailbox with delegates.

Mailbox with Forward To Report:

This report lists all mailboxes in an Exchange Organization that have enabled a "Forward
To".

To view the list of Mailboxes with Forward To report:
e Click on Reports -->> Mailboxes -->> Mailbox with Forward To.
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Mailbox Traffic Reports

This category provides reports on the traffic flow from and to mailboxes. The reports in
this category are based on Message Tracking Logs Gathering Task.

»'? e The reports can be viewed at summary or daily or hourly granular levels.
Hourly granular level can be selected only when the time period selected
is less than 2 days and the time period should be within the previous 35
days.
e If the report is at daily granular level, you can view the hourly report for
a date by clicking on the date displayed in the report.

The list of Mailbox Traffic Reports category are:
e Number of Messages By Sender
e Size of Messages By Sender
< Number of Messages By Receiver
e Size of Messages By Receiver
e Sent Traffic for Users

e Received Traffic for Users

Number of Messages By Sender Report:

This report provides complete information for message traffic between the exchange
servers in an organization.

To view Number of Messages by Sender Report:
1. Click on Reports -->> Mailbox Traffic -->> Number of Messages By Sender
2. Select the period.
3. Select the Granularity (Summary, Daily or Hourly)

Depending on the time period selected the graph displayed in the report changes. We
have two different types of graphs:

e Bar graph - Bar chart is displayed for summary granular level. This is the graph
that is displayed by default when the report is selected initially. The bar chart
displays the top 10 mailboxes by number of messages sent.

e Line Graph - Line graph is displayed for daily and hourly granular levels. The line
graph displayed only the top 5 mailboxes by number of messages sent.

Size of Messages by Sender Report:

This report provide complete information on the Size of Messages that was sent from
mailboxes (by users).

To view Size of Messages by Sender Report
1. Click on Reports -->> Mailbox Traffic -->> Size of Messages By Sender
2. Select the period.
3. Select the Granularity (Summary, Daily or Hourly)

—
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Depending on the time period selected the graph displayed in the report changes. We
have two different types of graphs:

e Bar graph - Bar chart is displayed for summary granular level. This is the graph
that is displayed by default when the report is selected initially. The bar chart
displays the top 10 mailboxes by the size of messages sent.

e Line Graph - Line graph is displayed for daily and hourly granular levels. The line
graph displayed only the top 5 mailboxes by size of messages sent.

Number of Messages by Receiver Report:

This report provide the complete information on the Number of Messages that was
received in mailboxes (by users).

To view Number of Messages by Receivers Report
1. Click on Reports -->> Mailbox Traffic -->> Number of Messages By Receiver
2. Select the period.
3. Select the Granularity (Summary, Daily or Hourly)

Depending on the time period selected the graph displayed in the report changes. We
have two different types of graphs:

e Bar graph - Bar chart is displayed for summary granular level. This is the graph
that is displayed by default when the report is selected initially. The bar chart
displays the top 10 mailboxes by number of messages received.

e Line Graph - Line graph is displayed for daily and hourly granular levels. The line
graph displayed only the top 5 mailboxes by number of messages received.

Size of Messages by Receiver Report:

This report provide information on Message Size that was received in mailboxes (by
users) in a selected Exchange Organization.

To view Size of Messages by Receivers Report
1. Click on Reports --=>> Mailbox Traffic -->> Size of Messages By Receiver
2. Select the period.
3. Select the Granularity (Summary, Daily or Hourly)

Depending on the time period selected the graph displayed in the report changes. We
have two different types of graphs:

e Bar graph - Bar chart is displayed for summary granular level. This is the graph
that is displayed by default when the report is selected initially. The bar chart
displays the top 10 mailboxes by the size of messages received.

e Line Graph - Line graph is displayed for daily and hourly granular levels. The line
graph displayed only the top 5 mailboxes by size of messages received.

“\
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Sent Traffic for Users Report:

This report provides detailed information on the email messages sent by a user or a group
of users by listing the message size, subject, ID and date for each email message that
was sent.

To view Sent Traffic for Users Report
Click on Reports -->> Mailbox Traffic --=>> Sent Traffic for Users
Select a single user or a group of Exchange users.

Select the period.

0N PR

Select the domain (Internal or External).

Received Traffic for Users Report:

This report shows the email messages that an Exchange user or a group of users received
within a specific time period with details of message size, subject, ID and date for every
individual email that was received.

To view Received Traffic for Users report
Click on Reports -->> Mailbox Traffic -->> Received Traffic for Users
Select a single user or a group of Exchange users.

Select the period.

PN PR

Select the domain (Internal or External).
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Mailbox Content Reports

This category provides reports to help you analyze mailboxes and mailbox folders based
on their content. Mailbox Content Reports is dependent on "Mailbox Content Gathering
Task".

scheduled only for one set of actions. A second "Mailbox content gathering task"

@‘ﬁ? Exchange Reporter Plus allows the "Mailbox Content Gathering Tasks" to be
will overwrite the existing schedule.

The reports present under this category are:
e Folder Message Count And Size
e Messages By Subject Keyword
e Messages By Body Keyword
e Attachments By File Name Keyword
e Attachments By File Extension Keyword

e Attachments By File Size
Folder Message Count And Size:

This report lists the Folders in a Mailbox. Mailbox Folder Path, Total Number of Messages
and Total Message Sizes for Folders in a Mailbox.

To view "Folder Message Count and Size" report:
1. Click on "Reports" -->=> "Mailbox Content" -->> "Folder Message Count and Size"

2. Click on Select link -->> Select Mailbox from the Pop-Up -->=>Click on "OK". (To
select a mailbox)

%,
?
@\ This report provides information on all folders in a single Mailbox.

Messages by Subject Keyword:

This report lists all messages that have a "specific keyword" as their message "subject"
in full or partial.

To view Messages by Subject Keyword report:
e Click on Reports -->> Mailbox Content -->>"Messages by Subject Keyword"

You can filter the report based on the "Subject keyword" using the "Filter" option.

- *’-? Only keywords defined during "Mailbox Content Gathering Task" scheduling are
@ considered for reporting.

h !
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Messages by Body Keyword:

This report lists all messages that have a "specific keyword" as their message "body"
in full or partial.

To view Messages by Body Keyword report:
e Click on Reports -->> Mailbox Content -->>"Messages by Body
Keyword" You can filter the report based on the "Body keyword" using the

"Filter" option.

*’-? Only keywords defined during "Mailbox Content Gathering Task™ scheduling
@ are considered for reporting.

h !

Attachments By File Name Keyword:

This report lists all messages that contain a "specific keyword" as their "Attachment
file name" in full or partial.

To view Messages by Attachment File Name Keyword report:
e Click on Reports -->> Mailbox Content -->>"Attachments By File Name
Keyword" You can filter the report based on the "Attachment File Name keyword" using

the "Filter"
option.

‘*:-? Only "Attachments By File Name Keywords" defined during "Mailbox Content
@ Gathering Task" scheduling are considered for reporting.

h !

Attachments By File Extension Keyword:

This report lists all messages that contain a "specific keyword" in their "Attachment
file name extension".

To view Messages by Attachment File Extension Keyword report:

e Click on Reports -->> Mailbox Content -->>"Attachments By File Extension
Keyword"

You can filter the report based on the "Attachment File Name extension" using the
"Filter" option.

*’-? Only "Attachments By File Extension Keywords" defined during "Mailbox Content
@. Gathering Task" scheduling are considered for reporting.

b !

Attachments By File Size:

This report lists messages that have an attachment which meets a user defined
"File size" condition.

The "Attachment File" size can have a value that is { >, >=, <, <=, =, I=} of a
numerical value, entered while scheduling a "mailbox content gathering task". Only
a single "File Size Limit" can be set while Task Scheduling/ Reporting.
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Example: If an Attachment File Size is set as ">1.8 MB" and scheduled in the
Mailbox Content Gathering Task, this report lists all messages that have an

attachment of size greater than 1.8 MB.

To view Messages by Attachment File Extension Keyword report:
Click on Reports --=>> Mailbox Content -->>"Attachments By File Size"

*-? Only "Attachments By File Size" defined during "Mailbox Content Gathering
@\ Task" scheduling are considered for reporting.
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Mailbox Permission Reports

This category provides reports on Mailbox Permissions. Permissions of users/groups over
mailboxes and permission of a mailbox over other mailboxes. The reports in this category
are based on Mailbox Permissions Gathering Task.

Mailbox Permission Reports include:
e Permissions based on Mailboxes

e Permissions based on Users

Permissions based on Mailboxes Report:
This report provides complete information on permission of mailbox over other mailboxes.
To view Permissions based on Mailboxes Report:

1. Click on Reports -->> Mailbox Permissions -->> Permissions based on Mailboxes

2. Click on the "Select link™ against "Mailbox™ to select the mailbox from the available
list (Any number of mailboxes can be selected).

3. This will list all the "users" who have Access Rights over the selected mailbox.

S . . -
¥ |When you select multiple mailboxes from the Pop-up, the report will list all the
users who have Access Rights over the selected mailboxes. Click on the user link
to identify mailboxes over which the user has specific permissions.

Permissions based on Users Report:

This report provides complete information on the Access Rights (permissions) of a
user/group over various mailboxes in the organization.

To view Permissions based on Users Report

1. Click on Reports -->> Mailbox Permissions -->>Permissions based on Users

2. Click on the "Select link" against "User/Group” to select the User or Group from the
available list shown in the Pop-up. (Any number of users/groups can be selected
from the list).

3. This will list all the "mailboxes" and the Access Rights available on those mailboxes.

V-? When you select multiple users/groups from the Pop-up, the report will list all
m the mailboxes and the corresponding Access Rights for each of those mailboxes.

Click on the mailbox to identify users / groups who have the listed permission

Access Right) shown against the mailbox.
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CustomRecipient Traffic Reports

This category provides reports on the traffic of "custom recipients” and "users of custom
recipients"”. A "User of a Custom Recipient"” is any mailbox enabled user who sends an
email to that custom recipient.

The reports in this category depend on Message Tracking Logs Gathering Task.

Hourly granular level can be selected only when the time period selected
is less than 2 days.

 If the report is at daily granular level, you can view the hourly report for
a date by clicking on the date displayed in the report.

[ﬁ? e The reports can be viewed at summary or daily or hourly granular levels.

h !

The List of Custom Recipient Traffic Reports are
e Custom Recipients by Message
e Custom Recipients by Size
e Users of Custom Recipients by Message

e Users of Custom Recipients by Size

Custom Recipients by Message:
The report lists the number of messages sent to custom recipients.

To view a report on Custom Recipients by Message report:

1. Click on Reports -->> Custom Recipients Traffic -->>Custom Recipients by
Messages

2. Select the "Period"
3. Select the "Granularity”

Depending on the time period selected the graph displayed in the report changes. We
have two different types of graphs:

e Bar graph - Bar chart is displayed for summary granular level. This is the graph
that is displayed by default when the report is selected initially. The bar chart
displays the top 10 Custom Recipient by number of messages sent to them.

e Line Graph - Line graph is displayed for daily and hourly granular levels. The line
graph displayed only the top 5 Custom Recipient by number of messages sent to
them.

Custom Recipients by Size:
The report lists the Size of messages sent to custom recipients.

To view a report on Custom Recipients by Message report:
1. Click on Reports -->> Custom Recipients Traffic -->>Custom Recipients by Size
2. Select the "Period"
3. Select the "Granularity"
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Depending on the time period selected the graph displayed in the report changes. We
have two different types of graphs:

e Bar graph - Bar chart is displayed for summary granular level. This is the graph
that is displayed by default when the report is selected initially. The bar chart
displays the top 10 Custom Recipient by the size of messages sent to them.

e Line Graph - Line graph is displayed for daily and hourly granular levels. The line
graph displayed only the top 5 Custom Recipient by the size of messages sent to
them.

Users of Custom Recipients by Message:

This report lists all Mailbox enabled users who have send messages to Custom Recipients
and the "Number of Messages" sent by the users to Custom Recipients.

To view Users of Custom Recipients by Message report:

1. Click on Reports -->> Custom Recipients Traffic -->>Users of Custom Recipients
by Messages

2. Select the "Period"
3. Select the "Granularity"

Depending on the time period selected the graph displayed in the report changes. We
have two different types of graphs:

e Bar graph - Bar chart is displayed for summary granular level. This is the graph
that is displayed by default when the report is selected initially. The bar chart
displays the top 10 Users with a mailbox who have sent maximum number of
messages to Custom Recipients

e Line Graph - Line graph is displayed for daily and hourly granular levels. The line
graph displayed only the top 5 Users with a mailbox who have sent maximum
number of messages to Custom Recipients.

Users of Custom Recipients by Size:
This report lists all Mailbox enabled users who have send messages to Custom Recipients
and the "Size of Messages" sent by the users to Custom Recipients.
To view a report on Users of Custom Recipients by Message report:
1. Click on Reports -->> Custom Recipients Traffic -->>Users of Custom Recipients
by Size
2. Select the "Period"
3. Select the "Granularity"

Depending on the time period selected the graph displayed in the report changes. We
have two different types of graphs:

e Bar graph - Bar chart is displayed for summary granular level. This is the graph
that is displayed by default when the report is selected initially. The bar chart
displays the top 10 Users with a mailbox who have sent maximum size of
messages to Custom Recipients

e Line Graph - Line graph is displayed for daily and hourly granular levels. The line
graph displayed only the top 5 Users with a mailbox who have sent maximum
size of messages to Custom Recipients.
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Intra - organization Traffic Reports

This category provides a list of reports to track the email traffic within the Exchange
organization. These reports provide important insights on the Exchange traffic between two
specific Exchange users, number and size of mails sent and received within the Exchange
organization and the overall traffic details on mails exchanged between users.

The reports under this category depend on "Traffic Logs Gathering Task".
The reports under Intra-Organizational category are:

e Mails Exchanged Between Users

e Number of Mails Sent By Users

e Size of Mails Sent By Users

e Number of Mails Received By Users

e Size of Mails Received By Users

o Traffic Between Two Specific Users

Mails Exchanged Between Users Report:

This report lists the total number and size of all email messages sent within the Exchange
organization towards users, public folders and groups along with the sender and recipient
display names.

To view Mails Exchanged Between Users report:

1. Click on "Reports” -->> "Email Traffic "-->>"Intra-Organizational Traffic "-->>

"Mails Exchanged Between Users".
2. Select the Period
Number of Mails Sent By Users Report:

This report lists the total count of email messages sent by the selected Exchange user(s)
to other users, public folders, groups within an Exchange organization along with the
recipient display name.
To view Number of Mails Sent By Users Report:

1. Click on "Reports" -->>="Email Traffic'-->> "Intra-Organizational Traffic "--

>=>"Number of Mails Sent By Users"

2. Select the Exchange user(s).

3. Select the time Period.
Size of Mails Sent By Users Report:

This report lists the size of email messages sent by the selected Exchange user(s) to
other Exchange recipients like users, groups, public folders along with the recipient
display names for each individual email message.

To view Size of Mails Sent By Users Report:

1. Click on "Reports" --=>=>"Email Traffic"-->> "Intra-Organizational Traffic "-->>"Size
of Mails Sent By Users"

2. Select the Exchange user(s).

Select the time Period.


http://localhost:8182/help/reports/intra-organization-traffic-reports.html#MailsExchangedBetweenUsers
http://localhost:8182/help/reports/intra-organization-traffic-reports.html#NumberofMailsSentByUsers
http://localhost:8182/help/reports/intra-organization-traffic-reports.html#SizeofMailsSentByUsers
http://localhost:8182/help/reports/intra-organization-traffic-reports.html#NumberofMailsReceivedByUsers
http://localhost:8182/help/reports/intra-organization-traffic-reports.html#SizeofMailsReceivedByUsers
http://localhost:8182/help/reports/intra-organization-traffic-reports.html#TrafficBetweenTwoSpecificUsers
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Number of Mails Received By Users Report:

This report shows the senders’ display name and the number of email messages received
by the specified Exchange user(s) with the individual message count.

To view Number of Mails Received By Users Report:

1.

2.
3.

Click on "Reports" -->>="Email Traffic'-->> "Intra-Organizational Traffic "--
>=>"Number of Mails Received By Users"

Select the Exchange user(s).

Select the time Period.

Size of Mails Received By Users Report:

This report shows the senders’ display name and the size of email messages received by
the specified Exchange user(s) with the size of individual messages.

To view Size of Mails Received By Users Report:

1.

2.
3.

Click on "Reports" -->>="Email Traffic'-->> "Intra-Organizational Traffic "-->>"Size
of Mails Received By Users"

Select the Exchange user(s).

Select the time Period.

Traffic Between Two Specific Users Report:

This report lists all the details of email messages exchanged between two specific users
with information like the date of exchange, size and subject of the message.

To view Traffic Between Two Specific Users Report:

1.

Click on "Reports" --=>=>"Email Traffic"-->> "Intra-Organizational Traffic "
-->>"Traffic Between Two Specific Users"

Select the Recipient Exchange mailbox.

Select the Sender Exchange mailbox.

Select the time Period.
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Overall Traffic from/to Internet Reports

This category of reports provides important insights on the traffic generated towards
internet. These reports provide data to track and monitor the outgoing and incoming
internet traffic by listing all the external domains with which email messages were
exchanged.

The reports under this category depend on "Traffic Logs Gathering Task".
The list of Overall Traffic from/to Internet Reports are:

e Number of Mails Sent to Internet

e Size of Mails Sent to Internet

e Number of Mails Received from Internet

e Sjze of Mails Received from Internet

Number of Mails Sent to Internet Report:

This report measures the outgoing traffic towards the internet by listing all the external
domains to which email messages were sent along with the aggregate count of messages
for each domain in a given period.

To view Number of Mails Sent to Internet Report:

1. Click on "Reports" --=>> "Email Traffic"-->>"Overall Traffic from/to Internet"--
>=>"Number of Mails Sent to Internet”

2. Select the Period

e Bar Chart - The top 10 external domains which topped by number of email
messages sent are displayed in the Bar Chart.

Size of Mails Sent to Internet Report:

This report also measures the outgoing internet traffic but on the basis of the total size of
email messages. This report lists all the external domains with the total size of all
messages sent towards the domain in a given time period.

To view Size of Mails Sent to Internet Report:

1. Click on "Reports" --=>> "Email Traffic'-->>"Overall Traffic from/to Internet"--
>="Size of Mails Sent to Internet"

2. Select the Period

e Bar Chart - The top 10 external domains by size are displayed in the Bar Chart.

Number of Mails Received from Internet Report:

This report monitors the incoming internet traffic by listing the external domains from
which email messages were received in a period with the count of messages.

To view Number of Mails Received from Internet Report:

1. Click on "Reports" -->> "Email Traffic"-->>"Overall Traffic from/to Internet"--
>=>"Number of Mails Received from Internet”

2. Select the Period

e Bar Chart - The top 10 external domains from which email messages were received
are listed in the Bar Chart.

/
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Size of Mails Received from Internet Report:

This report lists the top external domains generating internet traffic. This reports shows
the external domains from which email messages were received based on the total size of
email messages.

To view Size of Mails Received from Internet Report:

1. Click on "Reports" --=>> "Email Traffic"-->>"Overall Traffic from/to Internet"--
>>"Sjze of Mails Received from Internet"

2. Select the Period

e Bar Chart - The top 10 external domains from which email messages were received
are listed in the Bar Chart.
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Traffic from/to Internet (By Domain) Reports

This section of reports drills down the internet traffic data to specific external domains.
These reports provide the domain wise break down of the internet traffic by listing the top
senders and receivers for specific external domains.

The reports under this category depend on "Traffic Logs Gathering Task".
The list of Traffic from/to Internet (By Domain) Reports are:

e Number of Mails Sent to a Specific Domain

e Size of Mails Sent to a Specific Domain

¢ Number of Mails Received from a Specific Domain

e Size of Mails Received from a Specific Domain

Number of Mails Sent to a Specific Domain Report:

This report tracks the outgoing internet traffic for a specific external domain. This report
lists the Exchange users who sent mails to a particular external domain with the email
message count.

To view Number of Mails Sent to a Specific Domain Report:

1. Click on "Reports" --=>> "Email Traffic"'-->>"Traffic from/to Internet (By Domain)"--
>="Number of Mails Sent to a Specific Domain"

Select the external domain

3. Select the Period

e Bar Chart - The Bar Chart shows the top 10 Exchange users who sent emails to the
specific external domain based on message count.

Size of Mails Sent to a Specific Domain Report:

This report tracks the outgoing internet traffic towards a particular external domain based
on email message size. This report produces the list of Exchange users who sent mails to
the specified external domain based on the size of the email message.

To view Size of Mails Sent to a Specific Domain Report:

1. Click on "Reports™ --=>> "Email Traffic"-->>"Traffic from/to Internet (By Domain)"--
>>"Sijze of Mails Sent to a Specific Domain"

Select the external domain

3. Select the Period

e Bar Chart - The Bar Chart shows the top 10 Exchange users who sent mails to the
specific external domain based on message size.

Number of Mails Received from a Specific Domain Report:

This report shows incoming internet traffic from a specific external domain. This report
lists all the Exchange users who received email messages from the external domain along
with the email message count.

/


http://localhost:8182/help/reports/traffic-from-to-internet-by-domain.html#NumberofMailsSenttoaDomain
http://localhost:8182/help/reports/traffic-from-to-internet-by-domain.html#SizeofMailsSenttoaDomain
http://localhost:8182/help/reports/traffic-from-to-internet-by-domain.html#NumberofMailsReceivedfromaDomain
http://localhost:8182/help/reports/traffic-from-to-internet-by-domain.html#SizeofMailsReceivedfromaDomain

- =

‘Q ManageEngine Exchange Reporter Plus :: Help Documentation

L4

To view Number of Mails Received from a Specific Domain Report:

1. Click on "Reports" -->=> "Email Traffic"-->>"Traffic from/to Internet (By Domain)"--
>="Number of Mails Received from a Specific Domain"

2. Select the external domain
Select the Period

e Bar Chart - The Bar Chart shows the top 10 Exchange receivers with their email
message count.

Size of Mails Received from a Specific Domain Report:

This report also tracks the incoming traffic from a specific external domain in internet.
This report produces the list of Exchange receivers of email messages with the email
message size.

To view Size of Mails Received from a Specific Domain Report:

1. Click on "Reports" -->> "Email Traffic"-->>"Traffic from/to Internet (By Domain)"--
>="Sjze of Mails Received from a Specific Domain"

Select the external domain
Select the Period

e Bar Chart - The Bar Chart shows the top 10 Exchange receivers with the message
size.
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Traffic from/to Internet (By User) Reports

This category of reports funnels down the internet traffic data based on Exchange users.
These reports show the external domains with which the Exchange users have
communicated over a given time period. The external domains from which messages were
received and to which messages were sent are shown by both message count and size.

The reports under this category depend on "Traffic Logs Gathering Task".

The list of Traffic from/to Internet (By User) Reports are:
e Number of Mails Sent by Users
e Size of Mails Sent by Users
¢ Number of Mails Received by Users
e Size of Mails Received by Users
e Number of Mails Sent to a Specific Domain By A Given User

e Number of Mails Received from a Specific Domain By A Given User

Number of Mails Sent by Users Report:

This report tracks the external internet traffic for specific Exchange user(s). For the
selected Exchange user(s), the external domains and the number of email messages sent
towards each domain in a given time period are listed.

To view Number of Mails Sent by Users Report:

1. Click on "Reports" --=>> "Email Traffic'-->>"Traffic from/to Internet (By User)"--
>=>"Number of Mails Sent by Users"

2. Select the Exchange user(s)

3. Select the time period

Size of Mails Sent by Users Report:

This report helps in keeping track of the outgoing internet traffic of specific Exchange
user(s). The external domains and the total size of email messages sent towards the
domains are listed for the specified Exchange user(s).

To view Size of Mails Sent by Users Report:

1. Click on "Reports" -->> "Email Traffic"-->>"Traffic from/to Internet (By User)"--
>=>"Size of Mails Sent by Users"

2. Select the Exchange user(s)
3. Select the time period
Number of Mails Received by Users Report:

This report keeps a check on the incoming internet traffic for specific Exchange user(s).
This report lists the external domains from which email messages were received by the
user(s) with the total message count for each domain within a time period.
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To view Number of Mails Received by Users Report:

1. Click on "Reports" -->> "Email Traffic'-->>"Traffic from/to Internet (By User)"--
>=>"Number of Mails Received by Users"

2. Select the Exchange user(s)

3. Select the time period

Size of Mails Received by Users Report:

This report can produce the incoming internet traffic data for specific Exchange user(s).
This report lists the external domains and the total size of email messages received from
the domains by the selected user(s).

To view Size of Mails Received by Users Report:

1. Click on "Reports" -->> "Email Traffic"-->>"Traffic from/to Internet (By User)"--
>=>"Size of Mails Received by Users"

2. Select the Exchange user(s)

3. Select the time period

Number of Mails Sent to a Specific Domain By A Given User Report:

This report generates complete information on all the email messages that were sent by a
specific Exchange user to an external domain with details of the date, message size,
message ID, subject, number of recipients in the external domain and their email I1Ds.

To view Number of Mails Sent to a Specific Domain By A Given User Report:

1. Click on "Reports" --=>> "Email Traffic"-->>"Traffic from/to Internet (By User)"--
>="Number of Mails Sent to a Specific Domain By A Given User"

Select the Exchange user
Select the external domain

Select the time period

Number of Mails Received From a Specific Domain By A Given User:

This report shows the complete list of email messages that were received by a specific
Exchange user from a specific external domain in a time period with the details of date,
message size, message subject and the sender email address.

To view Number of Mails Received From a Specific Domain By A Given User Report:

1. Click on "Reports" -->> "Email Traffic"-->>"Traffic from/to Internet (By User)"--
>=>"Number of Mails Received From a Specific Domain By A Given User"

2. Select the Exchange user
Select the external domain

Select the time period
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DistributionList Reports

This category will provide information on Distribution lists, their Membership and inactive
Distribution lists in an Exchange Organization.

Reports under the Distribution Lists category are:
e Distribution Lists
e Distribution List Members

 Inactive Distribution List

Distributions Lists Report:

This report provides data on all Distribution Lists in a selected Exchange Organization.
The report is based on Essential data gathering task.

To view Distribution Lists report:

e Click on Reports -->=> Distribution Lists -->> Distribution Lists

Distribution List Members Report:

This report lists all Distribution List Members for any selected Distribution List. The
report is based on data gathered using Distribution List Membership Gathering Task.

To view Members of a Distribution List report:
1. Click on Reports -->=> Distribution List -->> Distribution List Members

2. Click on the Select link to select a "Distribution List Name" from the Pop-up.

Inactive Distributions Lists Report:

This report provides data on all Distribution Lists that are inactive for a period of 35 days
or more. The report is based on Message Tracking Logs Gathering task.

To view Inactive Distribution Lists report:

e Click on Reports -->=> Distribution Lists -->> Inactive Distribution Lists

/
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Distribution Lists Traffic Reports

This category provide valuable information about the distribution lists traffic in your
Exchange organization. The reports in this category depend on Message Tracking Logs
Gathering Task.

5’-? e The reports can be viewed at summary or daily or hourly granular levels.
[D Hourly granular level can be selected only when the time period selected
is less than 2 days.
« If the report is at daily granular level, you can view the hourly report for
a date by clicking on the date displayed in the report.

h !

The Reports under Distribution List Traffic category are:
e Distribution Lists by Message
e Distribution Lists by size
e Users of Distribution Lists by Message

e Users of Distribution Lists by size

Distribution Lists by Message:

The Distribution List by message report lists all Distribution Lists and their corresponding
number of messages sent.

To view a report on Distribution Lists by Message:
1. Click on Reports -->=> Distribution Lists Traffic -->>Distribution Lists by Messages
2. Select the "Period".
3. Select the "Granularity".

Depending on the time period selected the graph displayed in the report changes. We
have two different types of graphs:

e Bar graph - Bar chart is displayed for summary granular level. This is the graph
that is displayed by default when the report is selected initially. The bar chart
displays the top 10 Distribution Lists by number of messages sent.

e Line Graph - Line graph is displayed for daily and hourly granular levels. The line
graph displayed only the top 5 Distribution Lists by number of messages sent.

Distribution Lists by Size:

The Distribution List by size report lists all Distribution Lists and their corresponding size
of messages sent.

To view a report on Distribution Lists by Message:
1. Click on Reports -->=> Distribution Lists Traffic -->>Distribution Lists by size
2. Select the "Period".
3. Select the "Granularity".

—
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Depending on the time period selected the graph displayed in the report changes. We
have two different types of graphs:

e Bar graph - Bar chart is displayed for summary granular level. This is the graph
that is displayed by default when the report is selected initially. The bar chart
displays the top 10 Distribution Lists by size of messages sent.

e Line Graph - Line graph is displayed for daily and hourly granular levels. The line
graph displayed only the top 5 Distribution Lists by size of messages sent.

Users of Distribution Lists by Message:

The Users of Distribution List by message report lists all users who use Distribution Lists
and number of messages sent using Distribution Lists.

To view a report on Users of Distribution Lists by Message:

1. Click on Reports -->=> Distribution Lists Traffic -->>Users of Distribution Lists by
Messages

2. Select the Period.
3. Select the Granularity.

Depending on the time period selected the graph displayed in the report changes. We
have two different types of graphs:

e Bar graph - Bar chart is displayed for summary granular level. This is the graph
that is displayed by default when the report is selected initially. The bar chart
displays the top 10 Users of Distribution Lists who have send the maximum
number of messages.

e Line Graph - Line graph is displayed for daily and hourly granular levels. The line
graph displayed only the top 5 Users of Distribution Lists who have sent the
maximum number of messages.

Users of Distribution Lists by Size:

The Users of Distribution List by size report lists all users who use Distribution Lists and
their Message sizes used by the users.

To view a report on Users of Distribution Lists by Message:
1. Click on Reports -->=> Distribution Lists Traffic -->>Users of Distribution Lists by
size
2. Select the Period.
3. Select the Granularity.

Depending on the time period selected the graph displayed in the report changes. We
have two different types of graphs:

e Bar graph - Bar chart is displayed for summary granular level. This is the graph
that is displayed by default when the report is selected initially. The bar chart
displays the top 10 Users of Distribution Lists who have send the maximum size
of messages.

e Line Graph - Line graph is displayed for daily and hourly granular levels. The line
graph displayed only the top 5 Users of Distribution Lists who have sent the
maximum size of messages.
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PublicFolder Reports

This category provides reports on all the Public Folders in an Exchange Organization.
Public Folder reports are based on "Public Folder Properties Gathering Task"

The reports present under this category are:
1. Public Folder List
2. Mail Enabled Public Folders
3. Public Folder Replicas
4. Public Folder Size

Public Folder List:

This report lists all Public Folders in any selected Exchange Organization. Public Folder
List reports is based on "Public Folder Properties Gathering Task"

To view Public Folder List Report
e Click on Reports -->> Public Folders -->>Public Folders List

The report provides information on all available Public Folders, Public Folder Path and
their Last modified time for the selected Exchange Organization.

Mail Enabled Public Folders:

This report lists all Mail Enabled Public Folders in any selected Exchange Organization.
Mail Enabled Public Folder report is based on "Essential Data Gathering Task"

To view Mail Enabled Public Folders:
e Click on Reports -->=> Public Folders -->>Mail Enabled Public Folders

Public Folder Name, Public Folder Email and the Public Folder HomeMDB attribute are
listed.

Public Folder Replicas:

This report lists all Public Folder Replicas in any selected Exchange Organization. Public
Folder Replica report is based on "Public Folder Properties Gathering Task"

To view Public Folder Replicas Report
e Click on Reports --=>> Public Folders -->>Public Folders Replicas

The report provides information on all available Public Folders, Public Folder Path and
their corresponding Public Folder Replica Servers in the selected Exchange Organization.

*-? Use the "Funnel” Filter to the top right corner of the report to view Public Folder
[b Replicas available in a single Exchange Server.

b !
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Public Folder Size:

The Public Folder Size report provides information on the maximum size of public folders
on any given day or a selected period. Public Folder Size report is based on "Public
Folder Properties Gathering Task"

To view Public Folder Size Report

1. Click on Reports -->=> Public Folders -->>Public Folder Size
2. Select Period as "Today" or "Yesterday" for the selected day.

3. Select a custom period by entering the From and To dates. This lists the
maximum size of Public Folders in the selected period.

Both the "Number of Messages" and "Volume of Public Folder Messages" (MB) for the
selected period can be viewed.

You can view a graph that shows the "Top 10 Public Folders" by size. Click on any of the
Bars to view filtered information.
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PublicFolder Content Reports

This category provides reports that will help you analyze Public Folders based on their
content. Public Folder content that include message subject, message body, attachment
names, attachment extensions and attachment file sizes can be examined using these
reports.

The reports present under this category are:
e Messages by Subject Keyword
e Messages by Body Keyword
e Attachments by File Name Keyword
e Attachments by File Extension Keyword
e Attachments by File Size

The "Public Folder Content Reports" are based on "Public Folder Content Gathering
Task".

Messages by Subject Keyword:

This report lists all messages that have a "specific keyword" as their message "subject”

in full or partial.
To view Messages by Subject Keyword report:

e Click on Reports -->=> Public Folder Content -->>"Messages by Subject Keyword

You can filter the report based on the "Subject keyword" using the "Filter" option.

"-? Only "Subject keywords" defined during "Public Folder Content Gathering Task"
@\ are considered for reporting.

Messages by Body Keyword:

This report lists all messages that have a "specific keyword" as their message "body" in
full or partial.

To view Messages by Body Keyword report:
e Click on Reports -->=> Public Folder Content -->>"Messages by Body Keyword"
You can filter the report based on the "Body keyword" using the "Filter" option.

"'-? Only keywords defined during "Public Folder Content Gathering Task" are
[D\ considered for reporting.
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Attachments By File Name Keyword:

This report lists all messages that contain a "specific keyword" as their "Attachment file
name" in full or partial.

To view Messages by Attachment File Name Keyword report:

e Click on Reports -->=> Public Folder Content -->>"Attachments By File Name
Keyword"

You can filter the report based on the "Attachment File Name keyword" using the "Filter"
option.

5:-? Only "Attachments By File Name Keywords" defined during "Public Folder Content
@ Gathering Task" scheduling are considered for reporting.

Attachments By File Extension Keyword:

This report lists all messages that contain a "specific keyword" as their "Attachment file
name extension" in full or partial.

To view Messages by Attachment File Extension Keyword report:

e Click on Reports -->=> Public Folder Content -->>"Attachments By File Extension
Keyword"

You can filter the report based on the "Attachment File Name extension" using the
"Filter" option.

@‘ﬁ? Only "Attachments By File Extension Keywords" defined during "Public Folder

Content Gathering Task" scheduling are considered for reporting.

Attachments By File Size:

This report lists all messages that have an attachment with a "File size" defined during a
"Public Folder Content Gathering Task". The "Attachment File" size can have a value that
is { >, >=, <, <=, =, 1=} of a given numerical value.

Example: If an Attachment file size value is set as ">1.8 MB" and scheduled in the
"Public Folder Content Gathering Task", this report lists all messages that have an
attachment of size greater than 1.8 MB.

To view Messages by Attachment File Extension Keyword report:
e Click on Reports -->> Public Folder Content -->>"Attachments By File Size"

$”’_
@ Only "File Size limits" defined during "Public Folder Content Gathering Task"
scheduling are considered for reporting. Only a single "File Size Limit" can be
set while Task Scheduling/ Reporting.
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OutlookWeb Access Reports

This category provides reports on "Outlook Web Access" log ons in an Exchange
environment. The "Outlook Web Access Reports" are based on Outlook Web Access Info
Log Gathering Task.

The reports present under this category are:
e Log on By Users
e Browser Based Log on
e Client IP Based Log on

e Server Based Log on

Log on By Users:

This report provides information on the number of times users have logged on to their
mailboxes using Outlook Web Access.

To view Log on by users report:
1. Click on Reports -->>0utlook Web Access -->> Log on By Users
2. Select the Period.

Browser Based Log on:

This report provides information on the various Browsers and Browser versions used for
Outlook Web Access logons.

To view Browser Based Log on report:
1. Click on Reports -->>0utlook Web Access -->> Browser Based Log on
2. Select the Period.

Client IP Based Log on:

This report provides information on the Client IPs used for Outlook Web Access logons.
To view Client IP Based Log on report:

1. Click on Reports -->>0utlook Web Access -->> Client IP Based Log on

2. Select the Period.

Server Based Log on:

This report provides information on the Servers used for Outlook Web Access logons.
To view Server Based Log on report:

1. Click on Reports --=>>0utlook Web Access -->> Server Based Log on

2. Select the Period.
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Scheduling of Reports

Schedules can be set up in Exchange Reporter Plus to run selected reports automatically at
specified time intervals. Exchange Reporter Plus can also be configured to automatically
send an email of these scheduled reports to one or more users.

The reports scheduled to run are generated and stored at a user defined storage path.
These reports and can be e-mailed as a compressed zip file, a link or as an attachment in
any of the listed formats - pdf, xIs or csv.

To Schedule a New Report

e Click on "Reports" Tab

e Click on "Schedule New Reports" link to the top right corner of the product.(This will
take you to "Schedule Report" page.

e Enter the "Schedule Name" and the "Schedule Description" for the schedule in the
respective Text boxes.

e Select the "Organization Name" from the Drop Down.

e Select "Report Category" from the dropdown.(This will populate Reports
corresponding to the category selected).

e Select the "Report” from the dropdown.

e Click on the Radio button to Select the appropriate "Report Frequency".

e Click on the "File Storage Option" link to enter the location at which Scheduled
Reports will be stored.

e Select the Report format from the dropdown.

e Provide a check against "Email this scheduled Report" to email the scheduled report
to inputted email address.

Attribute Description

Schedule Enter a unique name to identify this schedule

Name

Description Enter a description corresponding to the schedule name.

Organization
Name

Select the organization name from the drop down. The Drop Down lists all
configured Exchange Organizations.

Scheduling a Report

Once the schedule name, its description and the Organization from where the schedule is
to be run is defined, the actual schedule creation needs to be done. The Scheduler
Creation section of Exchange Reporter Plus discusses about.

Selecting a Select a Report Category from the dropdown. Select the Report from the
Report to be dropdown.(Only reports corresponding to the Report Category will be
scheduled listed).

Schedule The "Selected Reports™ can be scheduled on a 'Hourly', 'Daily’, "Weekly"
Report or 'Monthly' basis. The report is scheduled to run once for the frequency
Frequency selected.

Schedule The Scheduled Reports can be stored in 'pdf', 'xlIs', or ‘csv' formats. They

Report Format

are stored at the "File Storage Path" entered by click on the "File Storage
Path" link.

Email
Notification

The scheduled report can be e-mailed to any email-id entered in the
"specify email address"” box on providing a check against "Email this
scheduled report".



http://localhost:8182/help/reports/scheduling-of-reports.html#Select Reports
http://localhost:8182/help/reports/scheduling-of-reports.html#Select Reports
http://localhost:8182/help/reports/scheduling-of-reports.html#Select Reports
http://localhost:8182/help/reports/scheduling-of-reports.html#Schedule Report Frequency
http://localhost:8182/help/reports/scheduling-of-reports.html#Schedule Report Frequency
http://localhost:8182/help/reports/scheduling-of-reports.html#Schedule Report Frequency
http://localhost:8182/help/reports/scheduling-of-reports.html#Schedule Report Format
http://localhost:8182/help/reports/scheduling-of-reports.html#Schedule Report Format
http://localhost:8182/help/reports/scheduling-of-reports.html#Email Notification
http://localhost:8182/help/reports/scheduling-of-reports.html#Email Notification

-

ManageEngine Exchange Reporter Plus :: Help Documentation )
)

—

Select Reports
Exchange Reporter Plus allows you to select and run reports at scheduled times. The

selection of all reports that are to be scheduled is done from the drop down.
e Select a Report Category from the dropdown.
e Select the Report from the dropdown.(Only reports corresponding to the Report
Category will be listed).

Schedule Report Frequency
e Different schedules will require different frequencies to be selected and this is

facilitated here. Exchange Reporter Plus allows to select the below frequencies.
e The schedule can be selected for daily, weekly or hourly by selecting the respective
radio buttons.

Frequency | Description

Hourly If you want to schedule this report to run every hour, enter the time after
which this report has to run every one hour.

Daily If you want to schedule this report to run every day, enter the time at
which this report has to run every day. With data being fetched 24 hours
from time of schedule (or) The previous day (0:00 hours to 23:59 hours)

Weekly If you want to schedule this report to run every week, enter the date and
time at which this report has to run every week. With data being fetched 7
days from day of schedule (or) The previous week (Monday to Sunday).

Monthly If you want to schedule this report to run every month, enter the day and

time at which this report has to run every month. With data being fetched
30 days from day of schedule (or) The previous month (Day 1 to Day 30).

Provided below are the steps to schedule an hourly report
e "Selected Reports" or the "Schedule" will be scheduled to run once every hour.
e To set the frequency of the schedule to "Hourly".

Select the "Hourly" Radio option under "Schedule Report Frequency"
Enter the Starting time for the Schedule. This schedule will be run on a
Hourly basis from the start time selected.

o
27

Previous Hour - When a user selects the "Last Hour" option from the drop
down. The data will be fetched once every time the clock ticks a valid hour.
Eg. (9:00 O’ Clock, 10:00 O' clock etc.)

Last 60 minutes - This depends on the start time selected. The data will be
fetched exactly 1 hour (60 minutes) from the time selected as start time.

Schedule Report Format

The Scheduled Reports can be stored in 'pdf', 'xIs’, or 'csv' formats by selecting
the format of choice from the drop down. They are stored at the "File Storage Path"
entered by click on the "File Storage Path" link.

1. The default "File Storage Path" is '%ProductHome Folder%\webapps\adap\schedule-
reports\ '. The user can change the storage path for the scheduled reports to any
desired location.

2. Outside the product it is 'D:\Exchange Reporter Plus\schedule-reports\ *
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""j If you modify the default "File storage path", scheduled reports cannot be
viewed through the web console.

Email Notification

The scheduled report can be sent to any email-id entered in the text box "specify email
address" on providing a check against "Email this scheduled report".

Email Notification requires

1. Configuring the "Message Settings"
2. Emailing the Scheduled Report

Message Settings

The "Message Settings™" needs to be configured to define the text message and the format
(link or attachment) in which the scheduled report will be delivered to a user’s email id.

To configure the "Message Settings"

e Click on the "Message Settings" link under Email Notification

e Select the options of your choice from the pop-up menu that is displayed.

e Enter the Mail content Entering the " Subject” and "Message" in their respective
boxes provided.

e Click on OK.

Options that can be selected to email or publish a scheduled report:

Email Reports as an | Reports are emailed as an attachment. The format of choice
attachment is selected under "Schedule Report Format" and could be
any of the selected formats pdf, csv, or xls.

Email Reports as a Zip | The selected reports are compressed to a zip format and
File emailed.

Publish the report and | Selecting this option the reports are published and the
email the link alone published link alone is emailed to users.

To notify a scheduled report by email:

e Provide a check against "Email this scheduled report” under Email Notification
section.

e Specify email address in the Text box that is displayed.

e Click on save.

This will email the scheduled report in the desired format (selected under "message
settings") to all entered email addresses.


http://localhost:8182/help/reports/scheduling-of-reports.html#Message Settings
http://localhost:8182/help/reports/scheduling-of-reports.html#Emailing
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Overview of Exchange Auditing

Microsoft Exchange is one of the most critical and fundamental application prevalent across
organizations. The safe and normal operation of an Exchange system always tops the
security requirements checklist. Auditing and reporting on all access to Exchange objects
and their permissions can ensure that sensitive information doesn’t land into wrong hands.
Hence Exchange auditing becomes critical to meet the compliance requirements and
ensure safe email operations.

Exchange Reporter Plus provides the auditing solution to track and report on various
Exchange events such as Mailbox logons, Mailbox permission change, Mailbox Properties
change and so on. Exchange Reporter Plus gathers all the required information from the
event logs of Exchange Servers and Domain Controllers and generates the Audit reports.
To record all significant events in the event logs, the Exchange server and the Domain
controller should first be configured.

How Exchange Auditing Works:
Exchange Server - Dom

2
“Event Logs” T "Event Logs”

ExchangeReporter Plus

Audit Reports
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System Requirements

Exchange Reporter Plus requires .NET Framework 3.5 Service Pack 1 for Exchange
Auditing.

By default, it is supported in the following platforms.
e Windows 7 and above
e Windows Server 2008 R2 and above

The .Net framework can be made available by installing it from the following link
Microsoft .NET Framework 3.5 Service Pack 1

Real-time Auditing

Real-time Auditing fetches Exchange data immediately as and when Exchange events are
written to the event logs. This feature is supported only if the product is installed on the
following platforms

e Windows 7

¢ Windows Vista

e Windows Server 2008

e Windows Server 2008 R2

Also, the Domain controller should be run on Windows Server 2008 or Windows Server
2008 R2.

/


http://www.microsoft.com/en-in/download/details.aspx?id=22
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Configuring Exchange Servers for Exchange Auditing

Diagnostic Logging should be configured in Exchange Servers to gain access to Mailbox
Logon reports. Upon configuration, the mailbox logon events are recorded in the
'Application Log’ in ‘Event Viewer ‘and further used for generating Mailbox Logon reports.
This topic explains the procedure to set the Diagnostic Logging levels using the Exchange
Management Shell and Exchange Management Console.

Use Exchange System Manager to configure Exchange Server
2003

e Open System Manager from Start -> All Programs -> Microsoft Exchange.

e In the console tree, expand Administrative Group, First Administrative Group
and Servers.

e Right click on the server and select "Properties".

W5 File  Action  View  Window Help |-|E’|i|

c= | OEXFEE 2 m

'T:d First Organization (Exchange) First Administrative Group

-3 Global Settings

0. Ren Mame
[+-{_J Recipienks =

B ini i L Servers
EI---._,j Administrative Groups e
w408 Exchange Administrative Group (FYDIBOHF235PD | — Connectors

E@ First Administrative Group i L3 Folders
: E-A Servers
I _
|ﬂ|_J ¢ onnactars Start Mailbox Management Procacs
._J FDIFIers N ,
EI@ SabhariTeskSabt Al Tasks ,
-3 Tools
Mew Window From Here
uf
Copy
Delete
Refresh
1] Properties

Help |

|Opens the properties dialog b

e On the Properties window, go to the Diagnostic logging tab
e Under Services, select MSExchangelS --=> Mailbox .

e Under Categories, select Logons.

e Under Logging level , Select Maximum.

e Click ok.
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Use Exchange Management Shell to configure Exchange Server
2007 and 2010

e Open Exchange Management Shell from Start -> Programs -> Microsoft
Exchange.
e Run the following command.

Set-EventLoglLevel "MSExchangel S\9000 Private\Logons" —Level Expert

g On configuring, all the available data from the event logs will be fetched.
[;\\ If there is no data in the event logs, please wait for the desired audit event and
event collection to happen.

Use Exchange Management Console to configure Exchange
Server 2007 and 2010

e Open Exchange Management Console from Start -> All Programs ->
Microsoft Exchange.

e In the console tree, navigate to Server configuration -> Mailbox
e Right click on the server and select Manage Diagnostic Logging Properties.

e On the Manage Diagnostic Logging Properties wizard page, expand
MSExchangelS --= 9000 Private and select Logons service.
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ge Management Console !El I
File  Action “iew Help
&= | 7= e
._.,_;_Microsoft Exchange Es Mailbox . act |Actiuns
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= EI Server Configuration - |5+ Export List...
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e Set the logging level as Expert.
e Click Configure.

e In Exchange Server 2007, Exchange Management Console can be used for
SP2 or later. For SP1 and earlier versions, use the Exchange Management

@T Shell.
e On configuring, all the available data from the event logs will be fetched.
If there is no data in the event logs, please wait for the desired audit

event and event collection to happen.

-- Manage Diagnostic Logging Properties

Configure Server | Configure Server Diagnostic Logging Properties

[ Diagrnostic Logging Select the services to configure then choose the logging level per categony.
Froperties

= > % Update logging levels for services
L Completion

FSE schange wWeb Services
PASE mchangesl
PASE schangedpplicationlogic
+]-- M SE nchangeFDS
=- FMSE xchangelS
=1~ 9000 Private
- Access Control
- Background Cleanup
- Drovwunload
- S Synchronization
- General
- Local Replication
- Logons
- MM Ta Connections
- Rules
- Send &

i Reset all services to default logging levels

Help I < Back I Configure I

[

T Lowest T Lows £ kedium i High = Expert

Cancel I



http://localhost:8181/help/audit/configuring-exchange-server.html#diagnostic-logging-with-powershell
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Configuring Domain Controllers for Exchange Auditing

Default Domain Controller Policy should be configured for accessing Mailbox Property
Changes and Mailbox Permission Changes reports. Upon configuration, events related
to mailbox permission and property changes will be recorded in the 'Security Log’ in 'Event
Viewer’ . Based on these event details, the Permission and Property Change reports are
generated.

Configuring Default Domain Controller Policy

1. Log on to a Domain Controller using an administrative account.

2. If Windows 2008, open Group Policy Management from Start ->
Administrative tools.

3. Navigate to ForestName -> Domains -> DomainName -> Group Policy
Objects -> Default Domain Controller Policy and right click to Edit it.

gﬁruup Policy Management !E.I

(3, File  Action  Wiew ‘Window  Help ‘-Iﬂlﬂ

G Al s

e i{;”p ey Hlonsemen; Default Domain Controllers Policy
=] Forest: xchange com

] | 2L i
= |55 Domains

Scope |Details| Settingsl Delegationl

= 3 child. xchange.com Links
ar Default Domain Policy Display link in thiz location: Ichild_ﬁchange_cgm _ﬂ
[ 3] Comp & Users o ; - -
® ) Do Mok Delete The fallowing sites, domaing, and OUs are linked to thiz GPO:
23] 3] Damain Controllers Location = I Enfun:edl Link En
4 out (2] Domain Cantrollsrs Mo Yes
o | Test
2 TestOU
= F] 3
[l | 57 Group Palicy Cbjects I I —]

—_'.', 5 Faul nmain I Edit... Security Filtering

- GPO1 PO Skatus b The settings in this GPO can only apply ta the following groups, users, and
® [ WM Filers e
! Back Up. ..
+ | 5] Skarter GPOs i
|:| & Restore from Backup... He,ﬁuthentlcated lzers
2 wchange.com :
® E Sites Impork Settings. .. . I | _}I
spy Group Policy Madeling 5ave Repart...
) Group Policy Results View » Add... Remove | Propertiss |
Mew Window From Here i
WHI Filtering
Copy ; L : ;
i Thiz GPO iz linked ta the fallowing W ter:
Renamme <nang: ll Op
Refresh
[0pen the GPO editor | |
Help
4. Navigate to Computer Configuration -> Policies-> Windows Settings ->

Security Settings -> Local Policies.

5. Select Audit Policy.
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7.

8.
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If Windows 2003 server, select Domain Controller Security Policy from
Start -> Administrative tools. Under Local Policies, select Audit Policy.

In the right pane, double click the following policies and enable "Success" and
"Failure™ settings.

o0 Audit directory service access
o0 Audit object access.

Click Ok.

s

On configuring, all the available data from the event logs will be fetched.
If there is no data in the event logs, please wait for the desired audit event
and event collection to happen.
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Configuring Domain Controllers for Exchange Auditing

Object level Auditing should be configured for accessing Mailbox Property Changes
and Mailbox Permission Changes reports. Upon configuration, events related to mailbox
permission and property changes will be recorded in the 'Security Log’ in 'Event Viewer’ .
Based on these event details, the Permission and Property Change reports are generated.

Configuring Object level Auditing

1. Open Active Directory Users and Computers from Start -> Administrative
Tools.

2. Select Advanced Features from View menu to view the advanced security
settings.

Fle  Acion | iew Help

)| 7

fdd/Remove Columns...

- Active Directory Users and Computers

=] B3

L

2

] mctive D Large Icons
M | savedt  Small Icons
Lisk

® [etal

| Deacription

v Advanced Features

Filter Cptions. ..

Users, Contacts, @roups, and Computers as containers

Default container for upar...

Default container For dom...
Default container For secu...

Customize. ..
I LostAndFound  lostAndFound Defaulk conkainer For arph,..
2 mahesh Organizational ...
| Managed Ser... Container Default container For man...
2 MTest Organizational ...
o out Organizational ...
| Praveenl465 Organizational ...
_|Program Data  Conkainer Defaulk location For storag...
| Syskem Conkainer Builtin syskem settings
2 Test Crganizational ..,
2| Testol Organizational ...
| Users Conkainer Defaulk conkainer for upar,..
| Microsoft Exc... msExchSystem...
| MTDS Quotas  msDS-QuotaCo...  Quota specifications cont. ..
| Infrastructure  infraskructurel. .,
I 2+l
|Enab|es;'disables advanced features and objects
3. In the left pane, right click on the Domain and select "Properties".
4. Under the Security tab, click "Advanced”™ to open the "Advanced Security

Settings for Domain' window.
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5. Under the Auditing tab, click ""Add" to add the security principal object to which
the policy will be applied.

6. Enter the object name as "Everyone' and click ok. This opens the "Auditing Entry
for the domain".
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Specify the Apply Onto field as follows

o If Windows Server 2008, Select "Descendant User objects"
o If Windows Server 2003, Select "User Objects"

Select ""Successful™ for the following Access

o Write All Properties
o Delete

o Modify Permissions
o All Extended Rights

Click ok.

=

On configuring, all the available data from the event logs will be fetched.
If there is no data in the event logs, please wait for the desired audit event and
event collection to happen.
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R auditing Entry for child I
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Delete all child objects

OO0RO0OBO0RED
00000000000
I
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Exchange Audit Reports

Exchange Auditing is crucial for reliable email messaging and security compliance
requirements. Exchange servers, Mailboxes, Quota limits, Permission changes should be
routinely monitored for keeping track of all access and the audit data can be maintained
and used for compliance requirements. To help audit Exchange data, Exchange Reporter
Plus offers some predefined audit reports. The existing reports can be customized or new
audit reports can be created.

The following are the predefined reports offered.
¢ Mailbox Logon Reports
¢ Mailbox Permission Changes Reports
¢ Mailbox Property Changes Reports

e Exchange Store Changes Reports

/
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Mailbox Logon Reports

Mailbox access auditing and reporting is a crucial step in not only ensuring security but also
in meeting the regulatory compliance standards. The reports under Mailbox Logon category
include

¢ Non-owner Mailbox Logon

e User Logon Activity

e Server-based Logon
Non-owner Mailbox Logon

Exchange Reporter Plus’s Non-owner Mailbox Logon audits and reports the non-owner
users who gained access to the other user mailboxes. This report list the users who
accessed the mailbox, the mailbox accessed and the server where the mailbox is located,
the users’ domain and the mailbox logon time within a selected time period. This allows
the Exchange administrators to detect any users trying to get unauthorized access to other
mailboxes.

To view Non-owner Mailbox Logon report,
e Click on Audit -->>Mailbox Logon Reports -->>Non-owner Mailbox Logon.
e Select the desired view for the data.
e Select the time period.

User Logon Activity

Auditing user logon to mailboxes is essential to gain a clear insight on the user activity.
This data can also help in meeting the compliance requirements. User Logon Activity report
tracks and lists the successful user logons to mailboxes along with the logon time stamp.
With the help of logon timestamps, it becomes easy to track, analyze and monitor the user
logon activity.

To view User Logon Activity report,
e Click on Audit -->>Mailbox Logon Reports -->>User Logon Activity.
e Select the desired view for the data.
e Select the time period.

Server-based Logon

Server-based Logon report is a consolidation of both the non-owner users and the user
logon activities. This report gives a clear picture of all the mailbox logons along with the
users who logged into the specified mailbox and the timestamp value.

To view Server-based Logon report,
e Click on Audit -->>Mailbox Logon Reports -->>Server-based Logon.
e Select the desired view for the data.

e Select the time period.

/
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Mailbox Permission Changes Reports

Assigning effective mailbox permissions ensures that only the right users get the intended
privileges for mailbox access. "Mailbox Permission Changes reports” from Exchange
Reporter Plus audits and reports on the users who recently changed the mailbox
permissions with the before and after value for the changed permission.

The reports under this category include
e Mailbox Permission Changes
¢ Mailbox Send As Permission Changes
e Overall Mailbox Permission Changes
Mailbox Permission Changes

This report lists the users who changed the permissions, their domains, the mailbox for
which the permission was modified, the modified permission with its old and new values
and the timestamp. Configuring this report with alert notifications can help in tracking all
users who recently changed the permissions and further monitoring their activity.

To view Mailbox Permission Changes report,

e Click on Audit -->>Mailbox Permission Changes reports -->> Mailbox Permission
Changes.

e Select the desired view for the data.
e Select the time period.
Mailbox Send As Permission Changes

Configuring ‘Send As permission’ rightly is important since it grants users other than the
mailbox owners the right to send messages using the mailbox. ’‘Mailbox Send As
Permission Changes’ report lists all the recent changes made with respect to send as
permission of users’ mailboxes. This report lists the user who changed the permission, the
user’s domain, the mailbox for which the permission was modified and the changed time
value.

To view Mailbox Send As Permission Changes report,

e Click on Audit --=>>Mailbox Permission Changes reports -->> Mailbox Send As
Permission Changes.

e Select the desired view for the data.
e Select the time period.

e Click on the 'Remarks’ column to know the user who has been given the Send As
permission.

e Click on the 'New’ and the ’Old’ value columns to know the changed Access Control
Entries.
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Overall Mailbox Permission Changes

This report provides information on mailbox permission changes including both the Full
access permission change and the Send as permission change. This report lists the users
who changed the permission, the target mailbox and the changed timestamp value.

To view Overall Mailbox Permission Changes report,

e Click on Audit --=>>Mailbox Permission Changes reports -->> Overall Mailbox
Permission Changes.

e Select the desired view for the data.
e Select the time period.
e Click on the 'Remarks’ column to know the ACEs added or removed..

e Click on the 'New’ and the 'Old’ value columns to know the changed Access Control
Entries.
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Mailbox Property Changes Reports

The list of reports under this category include
¢ Mailbox Quota Changes
e Message Size Restriction Changes
e Mailboxes Activated
e Mailboxes Deactivated
e Mailboxes Moved
Mailbox Quota Changes

"Mailbox Quota Changes" is a reporting solution that tracks and reports on the recently
modified mailbox quota limits. This report tracks modifications made to the mailbox quota
limits and displays the before and after value for the mailbox quotas. With this report, it
becomes possible to not just keep track of the modifications made but also on the users
who did such moaodifications, their domains and the timestamp corresponding to the
modification. This helps in detecting users who made excessive changes to the mailbox
properties due to delegated rights.

To view Mailbox Quota Changes report,
e Click on Audit -->>Mailbox Property Changes Reports -->> Mailbox Quota Changes.
e Select the desired view for the data.
e Select the time period.

Message Size Restriction Changes

Message size limits set for a user’s mailbox controls the size of messages that a user can
send and receive. 'Mailbox Size Restriction Change report’ lists the mailbox for which the
size limit was changed, the user who modified with details of the user’s domain and the
modified timestamp.

To view Message Size Restriction Changes report,

e Click on Audit -->>Mailbox Property Changes Reports -->> Message Size Restriction
Changes.

e Select the desired view for the data.
e Select the time period.

The 'Remarks’ column indicates whether the size restrictions are added newly, existing size
limitations are modified or the size restrictions are completely deleted. The 'New Value’
and the 'Old Value’ indicate the before and after size limit values.

Mailboxes Activated

This report lists all the mailboxes which were recently created or enabled with details of the
user who activated the mailbox, the user’s domain and the activated timestamp value.

To view Mailboxes Activated report,
e Click on Audit -->>Mailbox Property Changes Reports -->=> Mailboxes Activated.
e Select the desired view for the data.
e Select the time period.

The ‘Remarks’ column will indicate ’Attribute Added’ since the mailbox has been activated.

/
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Mailboxes Deactivated

This report lists all the mailboxes which were recently disabled or deleted with details of
the user who deactivated the mailbox, the user’s domain and the deactivated timestamp
value.

To view Mailboxes Deactivated report,
e Click on Audit -->>Mailbox Property Changes Reports -->> Mailboxes Deactivated.
e Select the desired view for the data.
e Select the time period.

The ’‘Remarks’ column will indicate ’‘Attribute Deleted’ since the mailbox has been
deactivated. The modified attribute homeMDB’s old value is shown in the ’'Old Value’
column.

Mailboxes Moved

This report lists the mailboxes that were moved from one mailbox store to another across
the Exchange organization with details of the user who moved the mailbox and the moved
timestamp value.

To view Mailboxes Moved report,
e Click on Audit --=>>Mailbox Property Changes Reports -->> Mailboxes Moved .
e Select the desired view for the data.
e Select the time period.

For Mailbox Moved report, the 'Remarks’ column will contain ’Attribute Modified’ value. The
new and the old values indicate where the mailbox has been moved.
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Exchange Store Changes Reports

Reports offered under this category include
e Exchange Stores Dismounted
e Exchange Stores Mounted

e User Action on Exchange Stores

Exchange Stores Dismounted

Exchange Information store being the storehouse of all Exchange mailboxes, sudden
dismount of stores can deny access to mailboxes for thousands of users. Exchange Stores
Dismounted report tracks and lists the public and private stores that were recently
dismounted within the specified time period along with details of the store name, type and
the dismounted time stamp. With alerts configured for this report, an Exchange
administrator can get immediate notification of such changes.

To view Exchange Stores Dismounted report,

e Click on Audit -->>Exchange Store Changes Reports -->> Exchange Stores
Dismounted.

e Select the desired view for the data.
e Select the time period.
Exchange Stores Mounted

Exchange Stores Mounted report helps in keeping track of both the public and private
stores that were mounted recently. This report also provides insight on the store name,
type and the mount time stamp value.

To view Exchange Stores Mounted report,

e Click on Audit -->>Exchange Store Changes Reports -->> Exchange Stores
Mounted.

e Select the desired view for the data.
e Select the time period.
User Action on Exchange Stores

User Action on Exchange Stores report consolidates the data on all the public and private
stores that were mounted or dismounted in the specified time period. This report lists the
store name, type and the operation that was performed on it with the corresponding time
stamp value.

To view User Action on Exchange Stores report,

e Click on Audit -->>Exchange Store Changes Reports -->>User Action on Exchange
Stores.

e Select the desired view for the data.

e Select the time period.

/
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The working behind Exchange Auditing

The Event Viewer, a component that helps in viewing the event logs does not facilitate
easy management of the logs. Hence getting the required data becomes a difficult and
time-consuming process. Also, the maintenance of these log entries for future analysis and
investigation purpose becomes a major challenge. With such inherent complexities
associated with Event Viewer, it becomes beyond necessity for a systematic mechanism in
place for getting the Exchange audit data from the logs. Here is where the "Action
Configuration™ in Exchange Reporter Plus comes into play.
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Action Configuration

Action Configuration simplifies the entire process of extracting the required information
from the event logs. It is a rule engine that defines "Report Actions" for each category of
reports, parses the event log and pulls out the required information based on the input
rules configured. These Report Actions are a collection of one or more "Rule Groups" that
define a set of filtering rules for extracting the data from the logs. Once the filtering rules
are satisfied as configured in the Report Action, the required data is successfully extracted
from the logs in a much more convenient way than the conventional way of reading form
the logs. The "Rule Groups" can be configured to either satisfy all or any of the filtering
rules. An action can be associated with multiple "Rule Groups" as well.

The various categories with the pre-configured Report Actions include the following:

Mailbox Logon Category

Mailbox Permission Changes Category
Mailbox Property Changes Category
Exchange Store Changes Category

1. Mailbox Logon Category

The preconfigured Report Actions for Mailbox Logon Category include the following:

Report Actions Description
Self-Logon Events This Report Action extracts the mailbox self-
logon data from the logs based on the rules
configured.
Non-Owner Logon Events This Report Action is configured to get data on
non-owner users who gained access to the other
user mailboxes.

To configure a new Mailbox Logon Action,

Click on "New Mailbox Logon Action".
Give the action a name and a description.

Enter a Rule group name.

PN PR

A rule group is a collection of filter rules. Specify the filter rules. The filter
rules can be created with the help of the variables listed. These variables
differ based on the category. The group of filter rules is combined based on
the logical operators: "AND" and "OR".

5. You can also add more than one rule group for an action using the "Add Rule
Group" option.

6. Save the configured action.
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2. Mailbox Permission Changes Category

The Report Actions under Mailbox Permission Changes Category include the

following:

Report Actions
Mailbox Permission Modified 2003

Description

This Report Action can be configured for
getting data on users who changed the
mailbox permissions in Windows Server 2003
environment.
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Mailbox Permission Modified 2008

This Report Action can be configured for
getting data on users who changed the
mailbox permissions in Windows Server 2008
environment.

Mailbox Send As Permission Change

This Report Action can be configured for
getting data on users who changed the
mailbox send as permission.

To configure a new Mailbox Permission Changes action, the same set of steps as mentioned

in Mailbox Logon Action creation can be followed.

3. Mailbox Property Changes Category

The Report Actions under Mailbox Property Changes category that are pre-configured

include the following:

Report Actions
Mailbox Quota Modified 2003

Description

This Report Action gets data on users who
changed the mailbox quota limits in Windows
Server 2003 environment.

Mailbox Quota Modified 2008

This Report Action gets data on users who
changed the mailbox quota limits in Windows
Server 2008 environment.

Message Size Restriction Change Event

This Report Action gets data on users who
changed the mailbox size limits.

Mailbox Activated Action

This Report Action gets data on the
mailboxes that were activated.

Mailbox Deactivated Action

This Report Action lists the mailboxes that
were deactivated.

Mailbox Moved Action

This Report Action lists the mailboxes that
were moved recently.

To configure a new Mailbox Property Changes action, the same set of steps as mentioned

in Mailbox Logon Action creation can be followed.



-y

ManageEngine Exchange Reporter Plus :: Help Documentation

4. Exchange Store Changes Category

The Report Actions configured under this category include the following:

Report Actions |
Mailbox Store Mounted

Description

A Report Action to extract data about all the
mailbox stores that were mounted with the
timestamp details.
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Mailbox Store Dismounted

A Report Action to extract data about all the
mailbox stores that were dismounted with
the timestamp details.

Public Store Mounted

A Report Action to extract data about all the
public stores that were mounted with the
timestamp details.

Public Store Dismounted

A Report Action to extract data about all the
public stores that were dismounted with the
timestamp details.

To configure a new Exchange Store Changes action, the same set of steps as mentioned in

Mailbox Logon Action creation can be followed.
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Report Configuration

The "Report Configuration” functionality of Exchange Reporter Plus takes the Exchange
audit data one step further by bringing the gathered information from the logs in the form
of reports. The parsed and extracted information from the logs is dynamically filtered
against the Exchange elements and the pulled out Exchange data is displayed in a simple,
uncluttered way in the form of reports. Each report data is stored in a separate table and
the information for graphs, charts and views is populated from the tables. These insights
help in seeing beyond the raw data and gaining actionable insights from it. With this
feature, new reports can be added.

Add new reports

In addition to the default reports offered, new reports can also be added. To add a new

report,

e Click on "Report Configuration" in the left pane.
e Click on the "Add New Report" option at the top right corner.
e Enter the "Report Name".

e Select the "Report Category" ' Mailbox Logon Reports, Mailbox Permission Change
Reports, Mailbox Properties Change Reports, and Organization Change Reports.

e Select the "Report Action” to be monitored.

Category | Report Actions
Mailbox Logon Reports e  Self-Logon Events

e Non-Owner Logon Events

Mailbox Permission Change Reports e Mailbox Permission Modified 2003
e Mailbox Permission Modified 2008

e Mailbox Send As Permission Change

Mailbox Properties Change Reports «  Mailbox Quota Modified 2003

e Mailbox Quota Modified 2008

e Message Size Restriction Change Event
e Mailbox Activated Action

e Mailbox Deactivated Action

e Mailbox Moved Action

Organization Change Reports e Mailbox Store Mounted

e Mailbox Store Dismounted
e Public Store Mounted

e Public Store Dismounted

e For Mailbox Logon, Mailbox Permission Change and Mailbox Properties Change
Report categories, select the "Target Mailbox" to be monitored.

e For Mailbox Logon, Mailbox Permission Change and Mailbox Properties Change
Report categories, select the "Caller Username" value. This field indicates the users
who need to be monitored.

e Click on the "Create" button to successfully create the new report.
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Schedule the existing reports

The existing reports can be configured for generation of data. To configure the report
scheduling,

1. Click on "Report Configuration" in the left pane.
2. Click on the "Configure" option.

3. Select the "Schedule Type" which determines the frequency in which the report will
be generated. The schedule type can be daily, weekly, monthly.

Select the "Time Period".
Enter the "Report Storage Path" and the "Report Format".

6. Enabling the "Email the scheduled report” will send the report after generation to
the email.

7. Save the schedule.
Enable/Disable the scheduled reports

Disabling a scheduled report will inactivate the report. The disabled report can be enabled
any time.

To enable or disable the scheduled reports, click on "Report Configuration” in the left pane.
1. Click on the @icon to disable the report. To enable the disabled report, use #icon.
Edit the scheduled reports
The scheduled reports can be modified or edited.
To edit the scheduled reports, click on "Report Configuration” in the left pane.
1. Click on the &icon against any scheduled report.
2. Change the report name, category, action, the target mailbox, caller username.
Delete the scheduled reports

1. To delete a scheduled report, Click on the i icon against any scheduled report
under "Report Configuration”.
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Views

A view is a possible way in which the information in the database can be potrayed. A view
can be thought of as a virtual table which doesn’t store the informtion but takes the
required data from other tables depending on the view type. There are 4 types of views
offered by Exchange Reporter Plus for viewing and analyzing the Exchange Audit data. The
views are

e Default view

e Summary view
e Cyclic view

e Pivot view

For all the four categories of Exchange Audit reports, the first three views are supported.
Pivot view is supported only for the Mailbox Logon Reports category.

In addition to the defined views, new views can also be created with View Customization
option.

Default view

The default view provides a raw data representation of the Exchange audit data. All the
data gathered from the Exchange sources within a specified time period are reported.
These raw data can be further consolidated based on specific attributes in the other types
of view.

For example, in case of Non-owner Mailbox Logon report, the default view provides
information on all the non-user logons with details of

e The Exchange users who accessed a mailbox
e The users’ domain

e The target mailbox name

e The server where the mailbox is located

e The logon time

All the above information is gathered and reported in the Default view. To view the
"Default view",

e Select any Exchange audit report.

e Click on the "Default view" tab

Summary View

Summary view offers a consolidated representation of the raw data provided in the Default
view based on a single attribute within a time period. For example, for the Non-user
Mailbox Logon report, the Summary view offers the total mailbox logon count for each
target mailbox.

The Summary view provides the following information
e The mailbox
e The total logon count

To view the "Summary view",
e Select any Exchange audit report.

e Click on the "Summary view" tab.

/
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Cyclic View
The Cyclic view provides period based consolidation of the data. This view goes one step
ahead of the summary view and provides data for each day within the selected time frame.

For example, with the Non-user Logon report, the cyclic view provides the non-user
domain based logon count for each day of the week within the selected time period. Hence
the report generates the following information

e Days of the week
e The total logon count for each day

The bar chart shows the weekly summary of domain based logon count value for each day
of the week.

To view the "Cyclic view",
e Select any Exchange audit report.

e Click on the "Cyclic view" tab.

Pivot View
The Pivot view groups the data based on two specific attributes within the specified time
period.

e Exchange servers

e Logon type

This view is supported only for the Mailbox Logon reports category. Hence when this view
is selected, the mailbox logon information will be reported based on the exchange servers
available in the organization and the total count of logons across each Exchange server.
Hence the reports will consist of

e Exchange servers used.

e The type of logons ’ total count of both self and non-user logon for each Exchange
Server.

A Stacked Bar graph with the logon count for each Exchange server is shown. To view the
"Pivot view",

e Select any Exchange audit report.

e Click on the "Pivot view" tab.
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View Customization

Create a View

In addition to the existing views offered, new views can be created for viewing the

Exchange audit data.

The "Create New View" option can be used for creating custom views. To create new views,

e Select the report for which a new view is to be created.
e Click on the "Create New View" option.
e Give the view a name.
e Select the view type — Summary, Cyclic or Pivot.
e If the view type is Summary

e Select the "Summary based on" value using which the summary data
will be consolidated.

e Select the "Range" to specify the top n values to be displayed in the
bar chart. The default value is 5.

e If the view type is Cyclic.
e Select "Granularity" level — Hourly, Weekly, Daily and Monthly.
e If the view type is Pivot which is supported only for Mailbox Logon reports.

e Select the "Pivot column"— Server or Mailbox indicating one of the
attributes based on which data will be consolidated.

e Select the "Pivot row" — Logon type

e Select the "Range" to specify the top n values to be displayed in the
bar chart. The default value is 5.

“\
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Fault Management

Exchange Reporter Plus incorporates Fault Management functionalities with the
introduction of the "Alerts" feature for Exchange audit reports. These alerts provide
insights on the critical events happening within the Exchange environment and they are
color coded based on the severity level. Alerts for specific events that require immediate
action like a non-owner user gaining access to a mailbox or a public or a private store
dismounting can be configured and the administrators or other Exchange users can be
notified. This can help in detecting the issues soon and taking a quick follow up action. The
alerts can be configured using the "Alert" option in the left pane.

When the Alert section is clicked, a window showing the alerts received is displayed. With
this window, the following actions can be done.

e Create a new alert profile
e Customize the existing alert profiles

¢ View Received Alerts
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Creating a New Alert Profile
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To create a new alert profile,

Click on "Alerts" option in the left pane.
Click on "Create New Alert Profile" option.
Give the alert a name and description.

Click on the plus icon to add the reports for which the alerts should be created. After
selecting the required reports, click on OK.

Construct an alert message with the macros available like User name, Mailbox, Time
Stamp and so on.

e For example, a sample alert message can be constructed as “USER_NAME
logged into ZMAILBOXZ. The alert message will be Xchange\administator
logged into adam@xchange.com.

Select the "Severity" level for the alert — Critical, Trouble and Attention based on the
alert seriousness.

Select on the "Email Notification™ option so that the created alert message can be
emailed.

e List the email id. If multiple ids exist, use "," to separate.

e Enter the subject of the email message.

Select "Create" to successfully create the alert profile.
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Customize Alert Profiles

All the alert profiles can be customized after creation. Click on "Alerts" option in the left
pane. Select ""Customize Alert Profiles'. All the alerts are listed and can be customized
as follows.

e Enable/Disable the alert profile

e Edit the existing alert profile

e Delete the alert profile

e Configure the alert for email notification

Enable / Disable the alert profile
To enable or disable an alert profile,
1. Click on the @icon to disable the profile. To enable the profile, use #icon.
Edit the existing Alert Profiles
To edit the existing alert profiles,
1. Click on the &icon against any alert profile.
2. Change the name, description, reports, alert message and severity level.
Delete the alert profile
To delete an alert profile,
1. Click on the @icon against any alert profile.
Configure the alert for email notification

If an email notification is not configured for an alert, using the "Configure" option it can
configured here. To configure email notification, click on "Configure™ option.
Check the email notification button.

1. List the email id. If multiple ids exist, use "," to separate.

2. Enter the subject of the email message.

3. Click on OK.


http://localhost:8181/help/audit/fault-management/customize-alert-profiles.html#Enable-disable-task
http://localhost:8181/help/audit/fault-management/customize-alert-profiles.html#Edit-task
http://localhost:8181/help/audit/fault-management/customize-alert-profiles.html#Delete
http://localhost:8181/help/audit/fault-management/customize-alert-profiles.html#Configure
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View Received Alerts

To view alerts, click on ""Alerts" option in the left pane. All the alerts are displayed with
the severity of the alert, the alert message received and the alert time stamp in the default
view. The alert view can be customized using the period selection and the filter option.

The filter option helps in grouping all the alerts based on the severity level. To filter the
received alerts,

e Click on the Filter button at the top right corner.
e Select a particular severity level.

e Select "Apply Filter" option.

To select alerts received in a specific time period,

e Select the "Period" drop down list and select the required time period. If "Custom
Period" is selected, enter the from and to dates.

By applying the period selection and filter option, only the alerts of selected severity level
within the specified time period will be displayed.

The "View Alerts" option also lists the available alerts while customizing or creating new
alerts.

Dashboard View of Alerts

Alerts are notifications of important events that require immediate attention. To ease out
the management of alerts, an "Alert" icon is added to the product dashboard at the top
right corner.

e Click on the "Alert" icon at the top right corner in the dashboard.

e An alert notification is displayed indicating the recent alerts available under each
severity level.

e To view all the alert information of a particular severity level, click on a severity.

In addition to the alert notification, the dashboard also provides the list of recent five alerts
with details of its severity, alert message, alert time details.

/
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Archive Configuration

The Archive Configuration of Exchange Reporter Plus allows the audit data to be archived
when it goes beyond a certain period. When the processed event log goes beyond the
specified time period, the data is removed from the working database and is written to a
separate SQL file for each time period. This file is zipped and stored in an archive folder in
a specific location. This helps in maintaining the working database size for optimum
performance.

To enable archiving,

Click on "Archive Configuration™ in the left pane.
Check the categories to be archived.

3. Specify the number of days beyond which the processed event log data should be
cleared from the database.

4. Specify the folder location for the archived data. By default the archived data is
stored in the product installation directory: "C:\Program
Files\ManageEngine\Exchange Reporter Plus\archive\"

5. Click on the "Run now" option for the cleanup schedule to run immediately. By
default, the cleanup schedule runs daily at 2:00 A.M.

6. Save the archive settings.
Restore Archived Events

The "Restore Archived Events" under Archive Configuration can be used to restore the
archived log data back into the working database. The archive folder specified in the
"Archive Configuration" settings will contain zipped files of audit data pertaining to any
category within a specific time period. Any of the archived data can be restored and
dumped into the database.

To restore archived data,

Click on the "Restore Archived Events" link at the top right corner.

All the archived data entries are listed with details of archive category, time period
and an option to load/unload the data.

3. The "Category" option at the top can be used to filter and display the archived data
entries pertaining to a single category.

4. To load archive data, click on "Load" =icon under Actions column.
5. Once the data is loaded, select a custom date range for viewing the reports.
Re-archiving Restored data

All the restored archived events are displayed with the "Unload" icon against them. This
will remove the restored data again from the database and archive it.

1. To unload the data again from the working database, click on the unload =xicon.

/

“=iw | Restored archive data older than 2 days (48 hours) in the database will be
[‘D‘ automatically re-archived.
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Troubleshooting

General Errors

Insufficient Privilege

Cause:

The user credentials provided in the Organization Settings page do not have sufficient

privilege.

Resolution:

The user credential provided should satisfy the below criteria.

Single domain forest

Multiple domain forest

Exchange The user credential should be
Management Shell added to the following groups.
available

1. Exchange Organization
Management
2. Domain Admins

The user credential should be
added to the following groups.

1. Exchange Organization
Management
2. Enterprise Admins

Exchange The user credential should be
Management Shell added to the Domain Admins
unavailable group.

1. Domain Admins

The user credential should be
added to the following groups.

1. Exchange Organization
Management
2. Enterprise Admins

The Servers are not operational

Cause:
This error could be due to any of the following reasons.

Domain Controllers are down.
Servers not available.

PONPE

The server is busy.

Resolution:

Firewall has been enabled, and port 389 is closed.

Exchange Reporter Plus uses port 389 for LDAP connection. If firewall is enabled, ensure

that the port 389 is added to the exception list.
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Exchange Server Configuration Errors

Diagnostic Logging configuration is required. If already configured, please wait
till any events occur.

Cause:

i. Diagnostic Logging has not been configured due to the unavailability of PowerShell.
ii. If configured, the desired audit event has not yet occurred.

Resolution:

i. To configure Diagnostic Logging, open Exchange Management Shell on any one of
the Exchange Servers and execute the below command after replacing with the
server name.

‘%SERVER_NAME%\MSExchangelS\9000 Private\Logons’ | Set-EventLogLevel
-Level ‘Expert’

ii. After automatic configuration of Diagnostic Logging, the desired audit event would
not have occurred. As a result there will be no data registered into the application
logs. Please wait for any events to be recorded in the logs and for event collection
to happen. In case of real-time events, data will be fetched immediately after the
event has occurred.

Domain Controller Configuration Errors

Access Denied

Cause:

The current credentials do not have sufficient privilege.

Resolution:

The user credential provided should satisfy the below criteria.

Exchange
Management Shell
available

Single domain forest

The user credential should be
added to the following groups.

1. Exchange Organization
Management
2. Domain Admins

Multiple domain forest
The user credential should be

added to the following groups.

1. Exchange Organization
Management
2. Enterprise Admins

Exchange
Management Shell
unavailable

The user credential should be
added to the Domain Admins

group.

1. Domain Admins

The user credential should be

added to the following groups.

1. Exchange Organization
Management
2. Enterprise Admins
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Configuration Failed

Cause:

The product would not be installed in the Exchange forest. Hence even after providing
credentials with right privilege, Default Domain Controller policy will fail to configure
automatically.

Resolution:
Configure Default Domain Controller Policy manually.
i) Log on to the domain controller using an administrative account.

i) If Windows 2008, open Group Policy Management from Start -> Administrative
tools.

iii) If Windows 2003, select Default Domain Controller Security Settings from Start
-> Administrative tools.

iv) Navigate to ForestName -> Domains -=> DomainName -> Group Policy Objects -
> Default Domain Controller Policy and right click to Edit it.

V) Navigate to Computer Configuration -=> Policies-=> Windows Settings -> Security
Settings -> Local Policies.

vi) Select Audit Policy.

vii) In the right pane, double click the following policies and enable "Success" and
"Failure™ settings.

e Audit directory service access
e Audit object access.

viii) Click Ok.

Reports

No data currently available for the report. Please wait for events.

Cause:
i. The desired audit events have not occurred. Hence there is no data currently available.
ii. The desired audit events have occurred. But the event collection is yet to happen.

iii. The Event Log Policy settings is configured for a small log size and "Overwrite events as
needed" is enabled.

Resolution:

i.Exchange Reporter Plus has swept through the logs but the desired events have not
occurred at the time of sweep. Wait for the desired audit events to be recorded in the
event logs.



Q ManageEngine Exchange Reporter Plus :: Help Documentation =
4

ii. Exchange Reporter Plus has a default ‘Event Fetch Interval’ of 2 hours for collecting the
data from the logs periodically. Manually initiate the event collection process by clicking on
the ‘Run Now’ link to immediately collect the data. For real-time events, there is no need to
initiate the event collection manually. The data will be collected once the events are
recorded to the logs.

iii. Ensure that the event log size is large enough so that the event log data will not get
lost.

No data found for the selected period and filter values.

Cause:

The desired audit events are not available for the selected time period and chosen filter
values.

Resolution:

Select a different time period and filter value to see the data in the reports.
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Admin

In this section we will discuss about the settings that need to be configured in Exchange
Reporter Plus.

Scheduling

e Task Scheduling - Allows you to schedule Various Data Gathering Tasks.

e Log/Store Path - Set the log paths for Message Tracking Logs and

e Outlook Web Access Info Logs (11S Logs) from here. Also, the Information
Store paths can be set.

e Organization Settings - Add a new Exchange Organization or modifying any
Exchange Organization using this option.

e Report Scheduling — Allows you to schedule reports by specifying the report
category, scheduling frequency, storage format and location.

Configurations

e Report Settings - Set default Time zone and Inactive period values using
this option. Internal Mail Domains can also be added.

« Product Settings - Configure Exchange Reporter Plus Connection Settings,
General Settings like logging level and Usage statistics gathering and the
theme of the product using this option.

 Mail Server Settings — Configure the Mail server settings with its port
number. The default to and from email address can also be set for report
scheduling.

Utilities

e User Management - Configure users and assign roles to them with which
they can access the product.

e License Management- Allows you to manage/unmanage Exchange
Mailboxes from where the product will gather data.

/
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Scheduling

The following are the scheduling options under "Admin" Tab in Exchange Reporter Plus.

e Task Scheduling - Allows you to schedule Various Data Gathering Tasks.

e Log/Store Path - Set the log paths for Message Tracking Logs and

e Outlook Web Access Info Logs (IIS Logs) from here. Also, the Information
Store paths can be set.

e Organization Settings - Add a new Exchange Organization or modifying any
Exchange Organization using this option.

e Report Scheduling — Allows you to schedule reports by specifying the report
category, scheduling frequency, storage format and location.



- u - . = —\\
Q ManageEngine Exchange Reporter Plus :: Help Documentation %)

TaskScheduling

Reports in Exchange Reporter Plus are based on the data collected from various
Exchange objects. To collect data Exchange Reporter Plus uses 9 built-in data gathering
tasks.

Each Data Gathering Task in Exchange Reporter Plus
e Performs data collection from a corresponding data source and
 Require task specific credentials.

These tasks must be scheduled for the reports to show latest data.

Under the Task Scheduling Action we will discuss:

Various Data Gathering Tasks in Exchange Reporter Plus

How to create New Data Gathering Schedules

Viewing existing schedules

Modifying or editing scheduled Tasks

ok~ LD PE

Viewing History of completed Schedules
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Data Gatherings by Exchange Reporter Plus

Exchange Reporter Plus gathers data from various data sources that include - Active
Directory, Exchange Servers, Mailbox, Public Folder, Message Tracking Log Files and
Outlook Web Access info Log Files (11S Logs).

This is done using one or more of 9 Data Gathering Tasks defined in Exchange
Reporter Plus.

Gathering information from the above mentioned data source necessitates minimum
privileges.

In this section we will discuss
1. Data Gathering Tasks run by Exchange Reporter Plus
2. Minimum privileges required for various data gatherings
3. Data gathering tasks and their corresponding data source

4. Scheduling a New Data Gathering Task

Data Gathering Tasks in Exchange Reporter Plus:

Exchange Reporter Plus has 8 built-in Data Gathering Tasks. These can be scheduled to
gather data from their respective Data Sources using the Task Scheduling option of
Exchange Reporter Plus. Listed below are the various data gathering tasks done by
Exchange Reporter Plus.

1. Essential data Gathering Task

Distribution List Membership Gathering Task
Mailbox Account Properties Gathering Task

Mailbox Content Gathering Task

Public Folder Properties Gathering Task

Public Folder Content Gathering Task

Traffic Logs Gathering Task

Outlook Web Access info (11S Logs) Gathering Task

© © N o g bk~ N

Mailbox Permissions Gathering Task

1. Essential Data Gathering Task

This gathering will collect the entire Exchange Organizational structure information like
the administrative groups, routing groups, servers and Mailboxes.(Schedule an Essential
Data Gathering Task)

2. Distribution List Membership Gathering Task

This gathering will collects the members of distribution lists in your Exchange
Organization. (Schedule a Distribution List Membership Gathering Task)
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3. Mailbox Account Properties Gathering Task

This will collect the size, number of messages in each of the mailboxes. It also collects
information about the mailbox last logon user and last logon time. (Schedule a Mailbox
Account Properties Gathering Task)

4. Mailbox Content Gathering Task

This gathering will search the mailbox folder contents for specific keywords. It searches
message subject, message body, attachment file names, attachment extensions,
attachment size. (Schedule a Mailbox Content Gathering Task)

5. Public Folder Properties Gathering Task

This gathering will collect all the public folders and their properties like size, number of
messages and replica servers. (Schedule a Public Folder Properties Gathering Task)

6. Public Folder Content Gathering Task

This gathering will search the public folder contents for specific keywords. It searches
message subject, message body, attachment file names, attachment extensions,
attachment size. (Schedule a Public Folder Content Gathering Task).

7. Traffic Logs Gathering Task

This gathering will collect mail traffic information from the message tracking log files.
The data from this gathering will be used to produce reports like top senders, top
receivers, server to server traffic analysis, organization traffic summary and more.
(Schedule a Message Tracking Logs Gathering Task)

(00:00 GMT). Logs which are not rolled-over might not have the data for the
entire day. Because of this Exchange Reporter Plus collects data, only from the
rolled over logs.

@*’-? Message Tracking Logs are rolled-over by Microsoft Exchange at every midnight

h !

8. OWA Logs Gathering Task

This gathering will collect Outlook Web Access related information like user logons,
logons based on server, logons based on Web Browsers and logons based on client IPs.
This information can be retrieved from "IIS Logs". (Schedule Outlook Web Access info
(11S Logs) Gathering Task)

9. Mailbox Permissions Gathering Task

This gathering will collect Mailbox Permissions from the mailboxes availble in the selected
Servers. (Schedule Mailbox Permission Gathering Task )



http://localhost:8182/help/admin/scheduling/task-scheduling/mailbox-permissions-gathering-task.html
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Privileges Required for Data Gatherings:

Each data gathering task will require minimum privileges to gather data from various
data sources. These privileges are entered at either of the below mentioned instances.

e Installation of Exchange Reporter Plus.

e Adding a New Exchange Organization (or)

e Scheduling a Data gathering task

The minimum privileges required for various data gatherings are tabled below.

Type of Data Gathering Privilege needed for Data Gathering \

Comprehensive information about |Administrator credentials possessing appropriate

Exchange Server permissions (Including those given in the below
rows).

Mailbox Data Exchange View only administrator who has a

mailbox. The mailbox should not be hidden
from the Global Address List(GAL).

Mailbox Content Data Any valid user credential with "Send as" / "receive
as" permissions on the mailboxes.
Exchange message tracking / Any valid user credential with read Access to the log

Outlook Web Access info Log files |[file remote share.
Public Folder Properties and Public |Any valid user credential with read access to Public
Folder Content Data Folders, about which information is to be gathered

Data Gathering Task and its corresponding Data Sources

Each Data Gathering Task in Exchange Reporter Plus is configured to collect data from
one or more mapped data sources. The below table lists the various Data Gathering
Tasks in Exchange Reporter Plus and their respective Data sources.

Data Gathering Task Data Sources

Essential data Gathering Task Active Directory and Exchange Server
Distribution List Membership Gathering Task|Active Directory

Mailbox Account Properties Gathering Task |Mailbox

Mailbox Content Gathering Task

Public Folder Properties Gathering Task Public Folder
Public Folder Content Gathering Task
Traffic Logs Gathering Task Message Tracking Log Files

OWA Logs Gathering Task 11S Log Files
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Howto Schedule Various Data Gathering Tasks

Scheduling New Data Gathering Tasks

Scheduling Data Gathering Tasks can be done from the Task Scheduling option of
Exchange Reporter Plus. Before scheduling a Data Gathering Task the following
parameters are to be taken into consideration.

1. Schedule Name
Schedule Description
Type of Data Gathering Task

2.

3

4. Schedule Type
5. Time Zone

6

Credentials

Schedule Name:

This is user defined and a user can input any schedule name corresponding to the data
gathering task.

Schedule Description:

Schedule description allows a user to add a description about the schedule.
Type of Data Gathering Task:

The various data gathering tasks in Exchange Reporter Plus are
Essential data Gathering Task ( How to Schedule)

Distribution List Membership Gathering Task (How to Schedule)
Mailbox Account Properties Gathering Task (How to Schedule)
Mailbox Content Gathering Task (How to Schedule)

Public Folder Properties Gathering Task (How to Schedule)
Public Folder Content Gathering Task (How to chedule)

N o g~ w DR

Message Tracking Logs Gathering Task (How to Schedule)

8. Outlook Web Access info (11S Logs) Gathering Task (How to Schedule)
Each of the "Data Gathering Tasks" listed above

e Gather data from corresponding data sources and

 Require task specific privileges.

Schedule Type:

Schedule Type defines the frequency in which the scheduled tasks will run. The schedule
type could be daily, weekly, monthly, only once, Repeat every N days or Run
Immediately.
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Schedule Type Schedule Type Description

Daily schedules Runs once every day at a scheduled time.
Weekly schedules Runs once every week on a given day and at the given time.
Monthly schedules |Runs once every month on a given date and at a given time.

Only once Runs only once at a specified time.
Repeat Every N Days|Runs once in every n days at a specified time.
Run Immediately Runs immediately (From the instant schedule is created).

Time Zone :

The time zone selection controls at what time zone the schedule will run. Local time zone

indicates the machine time on which Exchange Reporter Plus is installed.

Message Tracking Logs are rolled-over by Microsoft Exchange at every midnight (00:00

GMT). Logs which are not rolled-over might not have the data for the entire day.
Because of this Exchange Reporter Plus collects data, only from the rolled over logs.
Hence, appropriate selection of Time Zone is advised.

Credentials:

Each Data Gathering Task uses task specific credentials in-order to gather data from its

data source.

Why are task specific credentials required?
The credentials entered while adding an organization (From "Organization Settings"

Tab or while Installing the product) will be considered the default credential for that
"Exchange Organization". This will be used by default, while creating any "Data
Gathering Task" for that organization.

Usually, the default credentials provided in Exchange Reporter Plus will be of the
user who has the "highest level of privileges" in the corresponding Exchange
Organization.

Instead of providing a user with the highest level of privileges for data gathering
tasks (default credentials - if it was provided as mentioned above), Exchange
Reporter Plus also allows a user to provide a different set of credentials with
minimum privileges for that specific task.

For instance:
0 Message Tracking Log Gathering needs - "Read permissions on the Tracking
log share folders".
o0 Mailbox account properties gathering needs - "Exchange-view only
administrator" permissions.
In the above 2 cases Exchange Reporter Plus allows you to provide credentials
limiting to those privileges alone.

—
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SchedulingEssential Data Gathering Tasks

Scheduling Essential Data Gathering Tasks can be done from the Task Scheduling option
of Exchange Reporter Plus.

To schedule a New Essential Data Gathering Task
1. Click on "Admin" Tab -->> Task Scheduling -->> Schedule New Task

2. Select the "Exchange Organization” from which data is to be gathered [from drop
down]

Provide a "Schedule Name" and "Schedule Description”
Select the "Essential Data Gathering Task" from the "Task List" drop down.
Select the "Schedule Type".

Select the Time and Time Zone.

N o gk~ ow

Use default credentials or Enter task specific credentials. [Note: The
credentials provided while adding an Exchange organization will be used as
the default credentials.]

8. Click on Create.

This will schedule a New Essential Data Gathering Task.

: *’-? Essential Data gathering task gathers data from Exchange Servers and Active
@\ Directory.
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SchedulingDistribution List Membership GatheringTasks

Scheduling Data Gathering Tasks can be done from the Task Scheduling option of
Exchange Reporter Plus. Distribution List Membership Gathering Tasks will gather
membership information from all the distribution lists in your Active Directory. It requires
Administrator credentials possessing appropriate permissions.

To schedule a New Distribution List Membership Gathering Task

1.

N o M~ w

8.

This wi

Click on "Admin" Tab -->> Task Scheduling -->> Schedule New Task

Select the "Exchange Organization” from which data is to be gathered [from drop
down]

Provide a "Schedule Name" and "Schedule Description”

Select the "Distribution List Membership" from the "Task List" drop down.
Select the "Schedule Type".

Select the Time and Time Zone.

Use default credentials or Enter task specific credentials. [Note: The
credentials provided while adding an Exchange organization will be used as
the default credentials.]

Click on Create.
Il schedule a Distribution List Membership Gathering Task.

3

A scheduled task gathers data only from one Exchange Organization. Any
number of Distribution List Membership Data Gathering tasks can be scheduled.
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SchedulingMailbox Account Properties Gathering Tasks

Scheduling Data Gathering Tasks can be done from the Task Scheduling option of
Exchange Reporter Plus.

Mailbox Account Properties Gathering Tasks will gather mailbox sizes, "Number of
messages" in each mailbox, last logon user and last logon time from Exchange Servers.

For Exchange Reporter Plus to gather data on Mailbox Account Properties - Any valid
user credential with Exchange View only administrator privileges is required.

To schedule a New Mailbox Account Properties Data Gathering Task

1.
2.

N o g kM w

9.

Click on "Admin" Tab -->> Task Scheduling -->> Schedule New Task

Select the "Exchange Organization"” from which data is to be gathered [from drop
down]

Provide a "Schedule Name" and "Schedule Description”

Select the "Mailbox Account Properties” from the "Task List" drop down.
Select the "Schedule Type".

Select the Time and Time Zone.

Use default credentials or enter "Exchange View only administrator” credentials.
[Note: The credentials provided while adding an Exchange organization will be
used as the default credentials.]

Click on the "Add" button against "Data Sources"

1. Select the Exchange Servers for which mailbox account properties are
required.

Click on Create.

This will schedule a Mailbox Account Properties Data Gathering Task.

[B?‘

A scheduled tasks gathers data only from one Exchange Organization. Any
number of Mailbox Account Properties Data Gatherings can be scheduled.
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SchedulingMailbox Content Gathering Tasks

Scheduling Data Gathering Tasks can be done from the Task Scheduling option of
Exchange Reporter Plus.

Mailbox Content Gathering Tasks will gather mailbox Folder content that include
Messages and Attachments. The content can be filtered by keyword, file name, file
extension or file size. It gathers data from all selected Mailboxes in the Exchange

Organization.

For Mailbox Content Gathering Task a user with "Send as" / "receive as" permissions on
the mailboxes for which you require data" is needed.

To schedule a New Mailbox Content Gathering Task

1.

N o o M w

10.

Click on "Admin" Tab -->> Task Scheduling -->> Schedule New Task

Select the "Exchange Organization” from which data is to be gathered [from drop

down]

Provide a "Schedule Name" and "Schedule Description”

Select the "Mailbox Content" from the "Task List" drop down.

Select the "Schedule Type".

Select the Time and Time Zone.

Use default credentials or enter "Any valid user credential with "send as" and
"receive as" permissions on the mailboxes selected"”. [Note: The credentials
provided while adding an Exchange organization will be used as the default
credentials.]

Click on Add button to add Data Sources

1.

o gk~ w

The Data Source for a Mailbox Content Gathering Task is the mailboxes in the
Exchange Server.

Exchange Reporter Plus allows selection of one or multiple mailboxes from
which content will be gathered. This can be done by selecting

"Individual Mailboxes",
"Organizational Units" or
"Mailbox Stores".

Click on Ok (This selects checked mailboxes for content verification).

Click on "Edit" to change the Data Sources selected.

Exchange Reporter Plus allows filtering of the mail content by one or all of the
below mentioned fields.(Multiple Keywords Must Be Separated By Semicolon ";" ).
A minimum of one filter keyword must be entered, this is a mandatory
requirement.

(o}
(o}
(o}
(0}
(0}

"Message Subject”
"Message Body"
"Attachment File Name"
"Attachment File Extension"
"Attachment File Size".

11. Click on Create.

This will schedule a Mailbox Content Data Gathering Task.

—
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Content Gathering is limited to mailboxes of a selected Exchange
Organization.

e To gather Mailbox Content for a second Exchange Organization, the
existing Mailbox Content Gathering Task must be deleted.

e Creation of a New Mailbox Content Data Gathering Task will overwrite
the data collected by the previous content gathering task.

@*’-T e Only one Mailbox Content Data Gathering Task can be configured. Mailbox
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SchedulingPublic Folder Properties Gathering Tasks

Scheduling Data Gathering Tasks can be done from the Task Scheduling option of
Exchange Reporter Plus.

Public Folder Properties Gathering Tasks will gather public folders and their properties
like size, number of messages and replica server information. It gathers data from Public
Folders.

To schedule a New Public Folder Properties Data Gathering Task
1. Click on "Admin" Tab -->> Task Scheduling -->> Schedule New Task

2. Select the "Exchange Organization” from which data is to be gathered [from drop
down]

3. Provide a "Schedule Name" and "Schedule Description”

4. Select the "Public Folder Properties" from the "Task List" drop down.
5. Select the "Schedule Type".

6. Select the Time and Time Zone.

7

Use default credentials. [Note: The credentials provided while adding an Exchange
organization will be used as the default credentials.]

8. Click on Create.

This will schedule a Public Folder Properties Data Gathering Task.

5'-? A scheduled tasks gathers data only from one Exchange Organization. Any
@ number of Public Folder Properties Data Gatherings can be scheduled.

h !
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SchedulingPublic Folder Content Gathering Tasks

Scheduling Data Gathering Tasks can be done from the Task Scheduling option of
Exchange Reporter Plus.

Public Folder Content Gathering Tasks will gather Public Folder content (Messages and
Attachments). The content can be filtered by one or all of the filter options - message
body, message subject, file name, file extension or file size. It gathers data from all
selected Public Folders in a selected Exchange Organization.

To schedule a New Public Folder Content Gathering Task
1. Click on "Admin" Tab -->> Task Scheduling -->> Schedule New Task

2. Select the "Exchange Organization” from which data is to be gathered [from drop
down]

3. Provide a "Schedule Name" and "Schedule Description”

4. Select the "Public Folder Content" from the "Task List" drop down.
5. Select the "Schedule Type".

6. Select the Time and Time Zone.

7

. Use default credentials. [Note: The credentials provided while adding an Exchange
organization will be used as the default credentials.]

8. Click on Add button to add Data Sources

1. The Data Source for a Public Folder Content Gathering Task are the "Public
Folders" in the Exchange Organization.

2. Exchange Reporter Plus allows selection of one or multiple "Public Folder".
3. Click on Ok (This selects checked Public Folders for content gatherings).
9. Click on "Edit" to change the Data Sources selected.

10. Exchange Reporter Plus allows filtering of the mail content by one or all of the
below mentioned fields.(Multiple Keywords Must Be Separated By Semicolon ";" ).
A minimum of one filter keyword must be entered, this is a mandatory
requirement.

o "Message Subject",

o "Message Body",

o "Attachment File Name",

o "Attachment File Extension" and
o "Attachment File Size".

11. Click on Create.
This will schedule a Public Folder Content Gathering Task.

¥

@? e Public Folder Content Gathering Tasks can be scheduled only if the Public

Folder Properties gathering task is run.

e Only One Public Folder Content Gathering Task is allowed.

e Creation of a New Public Folder Content Gathering Task will overwrite the
data collected by the previous content gathering task.

e Public Folder Content Gathering Task can be scheduled within an Exchange
Organization. Creation of a Public Folder Content Gathering task for the
second Exchange Organization requires deleting the existing one.
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Scheduling Traffic Logs Gathering Tasks

The Hub Transport Server role, which is responsible for handling all the mail flow within
the organization, logs all the email traffic data across the Exchange objects in the
Message Tracking Logs. Exchange Reporter Plus collects the traffic data from these log
files and stores it as raw data for producing the following "Drill down reports".

Intra — Organizational Traffic reports

Overall Traffic from/to Internet reports
Traffic from/to Internet (By Domain) reports
Traffic from/to Internet (By User) reports

PoDdE

These raw data are further processed and aggregated to get hourly and daily email traffic
reports. Scheduling Traffic Logs Tasks can be done from the Task Scheduling option of
Exchange Reporter Plus.

To schedule a New Message Tracking Logs Gathering Task
1. Click on "Admin" Tab -->> Task Scheduling -->> Schedule New Task

2. Select the "Exchange Organization” from which data is to be gathered [from drop
down]

3. Provide a "Schedule Name" and "Schedule Description”

4. Select the "Message Tracking Logs Gathering Task" from the "Task List" drop
down.

5. Select the "Schedule Type".
6. Select the Time and Time Zone.

7. Use default credentials or Enter task specific credentials. [Note: The
credentials provided while adding an Exchange organization will be used as
the default credentials.]

8. Select the "log files date" for which log Files will be gathered and parsed. This can
be done either by selecting either of the below options.

1. "Yesterday" which will collect yesterday'’s log file
2. "Custom period" which will collect log files for a specific date range.

3. "Last N Days" which will collect log files for "N" number of days in the
immediate past.

9. Click on "Add" to add Exchange Server from where Message Tracking logs are to
be gathered.

10. Click on Create.

This will schedule a New Message Tracking Log Gathering Task.


http://localhost:8182/help/reports/intra-organization-traffic-reports.html
http://localhost:8182/help/reports/overall-traffic-from-to-internet.html
http://localhost:8182/help/reports/traffic-from-to-internet-by-domain.html
http://localhost:8182/help/reports/traffic-from-to-internet-by-user.html
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midnight (00:00 GMT). Logs which are not rolled-over might not have
the data for the entire day. Because of this Exchange Reporter Plus
collects data, only from the rolled over logs.

@? e Message Tracking Logs are rolled-over by Microsoft Exchange every

e Message Tracking Logs are gathered from Exchange Servers from the
default log path. If there is any change in the log path you can
update the log path using the "Log Path configuration" option of
Exchange Reporter Plus.

< Exchange Reporter Plus performs a cleanup process to reduce the
database size since large amount of traffic details will get
accumulated. All the "Drill down report data" and "Mailbox Traffic
hourly report data™ older than 35 days will be removed from the
working database. The cleanup period of 35 days can be configured.
To change the settings, contact the support team at
support@exchangereporterplus.com.
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SchedulingOutlook Web Access Info Log GatheringTasks

This Task collects IIS log files from the Exchange Server and parses the log files for
Outlook Web Access (OWA) Logon information. OWA Logon information collected by
Exchange Reporter Plus will be used to generate reports like - Log on By Users, Browser
based Log on, Client IP based Log on and Server based Log on.

To schedule a New Outlook Web Access info Log Gathering Task
1. Click on "Admin" Tab -->> Task Scheduling -->> Schedule New Task
Select the "Exchange Organization"” from which data is to be gathered.

Provide a "Schedule Name" and "Schedule Description”

2
3
4. Select the "Outlook Web Access Info Logs" from the "Task List" drop down.
5. Select the "Schedule Type".

6. Select the "Time" and "Time Zone".

7

Use default credentials OR any user credential who has read access to the log file
remote shares. [Note: The credentials provided while adding an Exchange
organization will be used as the default credentials.]

8. Select the "log files date" for which log Files will be gathered and parsed. This can
be done either by selecting either of the below options

1. "Yesterday" which will collect yesterday'’s log file
2. "Custom period" which will collect log files for a specific date range.

3. "Last N Days" which will collect log files for "N" number of days in the
immediate past.

9. Click on "Add" to add Exchange Server from where IIS logs are to be gathered.
10. Click on Create.

This will create a new Outlook Web Access Info (11S) Log gathering schedule with the
above configured settings.

@? I1S Logs are gathered from Exchange Servers from the default log path. If there

is any change in the log path you can update the log path using the "Log Path

* |configuration” option of Exchange Reporter Plus.

11S Log Files Configuration:

Some default fields should be available in IS Log files to extract Outlook Web Access
Information. Shown below are the steps to enable logging for 11S6 and 11S7 Servers and
also the default fields required for each of these servers..

Steps to enable Logging in 11S6 Servers :

1. On the Taskbar, click Start -->> Control Panel-->>Administrative Tools--
>>Internet Information Services (11S) Manager.

2. Right Click on Websites-->>Default Web Site and select Properties
3. Click Properties button under Enable Logging section
4. Click on Advanced Tab
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5. Ensure that the following fields are selected :
o date
o time
0 cs-uri-stem o

cs-uri-query

cs-username

c-ip

cs(User-Agent)

sc-status

o O O O

Steps to enable Logging in 11S7 Servers:

1. On the Taskbar, click Start, point to Administrative Tools, and then click
Internet Information Services (11S) Manager.

2. In the Connections pane, expand the server name, expand Sites, and then click
the Web site on which you want to configure (Default is W3SVC1) logging.

In the Home pane, double-click Logging.
4. Click on Select Fields

5. In the W3C Logging Fields ensure that the following fields are selected :
0 date
o time
0 Cs-uri-stem o

cs-uri-query

cs-username

c-ip

cs(User-Agent)

sc-status

O O O ©

6. Click ok and click on Apply in the right hand side pane
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Mailbox Permissions GatheringTasks

Scheduling Data Gathering Tasks can be done from the Task Scheduling option of Exchange
Reporter Plus.

Mailbox Properties will be gathered from all the Exchange Servers selected.

To schedule a New Mailbox Permissions Gathering Task

1.
2.

N o o kW

9.

Click on "Admin" Tab -->> Task Scheduling --=>> Schedule New Task

Select the "Exchange Organization™ from which data is to be gathered [from drop
down]

Provide a "Schedule Name" and "Schedule Description”

Select the "Mailbox Permission™ from the "Task List" drop down.
Select the "Schedule Type".

Select the Time and Time Zone.

Use "default credentials” or enter a user who has "Read Permissions" on the
corresponding Mailboxes. [Note: The credentials provided while adding an Exchange
organization will be used as the default credentials.]

Click on the "Add" button against "Data Sources™.

1. Select the Exchange Servers for which the mailbox permissions are required.
Click on Create.

This will schedule a Mailbox Permission Gathering Task.

A scheduled tasks gathers data only from one Exchange Organization. Any humber
of Mailbox Permission Gatherings can be scheduled.




@J ManageEngine Exchange Reporter Plus :: Help Documentation )

Viewing Scheduled Tasks

Schedules are configured in Exchange Reporter Plus to gather relevant data from various
data sources. Exchange Reporter Plus allows creation of multiple schedules for most data
gathering tasks. However, only one schedule can be created for Mailbox Content
gathering and Public Folder Content gathering tasks.

All the Data Gathering tasks scheduled in Exchange Reporter Plus can be viewed from
the "Scheduled Tasks" page,

The "Scheduled Tasks" page provides complete information about the schedules. You can
modify, delete, enable or disable the schedules that are listed in the page.

To view Scheduled Tasks :
1. Click on the "Admin" Tab
2. Click on "Task Scheduling" option under 'Scheduling"

This lists all the tasks that are scheduled.

Following are the fields available under a "scheduled task":

Fields Description \
Action The options under the Actions Column allows one to Modify, delete,
enable or disable the schedule.

Schedule Name |The name provided by the user. Click on any "Schedule Name" to view
the complete details of the schedule.

Schedule User defined description for schedule.
Description

Gathering Task |The "Data Gathering Task" for which the schedule is created.

Schedule Time |It displays the time at which the scheduled task will run.

Gathering The servers from which data gatherings will be done can be viewed.
Servers

[ﬁ?. You cannot modify, delete or disable a run-immediately schedule.

Default Schedules shown under Schedule Tasks:

Some of the Scheduled Tasks will be listed under the Scheduled Task history
immediately after installation or when a new Exchange Organization is added. These are
run immediately schedules created by default, so that a new user can view reports on
Exchange Reporter Plus immediately after it is installed.

Following are the schedules created by default when a new "Exchange Organization” is
added:

1. Essential Data gathering.

2. Distribution list membership gathering.

3. Mailbox account properties gathering.

4. Message tracking logs gathering.

5. Outlook Web Access Info Logs gathering.

/
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[;T All reports will not have data to show immediately after installation. Only reports
that are based on data gathered from the default schedules can be viewed.

1. The following default daily tasks are scheduled by arbitrarily choosing one
exchange server.

e Mailbox account properties gathering.
e Traffic logs gathering.
e Outlook Web Access Logs gathering.

To view data in all the reports you will need to create appropriate schedules.

3. Creating schedules (Data Gathering Tasks) manually can be done from the
Task Scheduling option.

4. The Reports based on Data Gatherings table will guide you with the "Data
Gathering task™ you need to schedule in-order to collect appropriate data for
a report.



http://localhost:8182/help/admin/scheduling/task-scheduling/task-scheduling.html
http://localhost:8182/help/reports/reports-based-on-data-gatherings.html
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Modifying Scheduled Tasks

Scheduled tasks listed under the "Scheduled Tasks" page can be enabled, disabled,
edited or deleted.

e Enable / Disable "Scheduled Tasks"
e Edit "Scheduled Tasks"
e Delete "Scheduled Tasks"

Enable / Disable "Scheduled Tasks"

Disabling a scheduled task will inactivate future data gatherings for that schedule. You
can at any time enable a schedule that is disabled.

To Enable or Disable Scheduled Tasks :
1. Click on the "Admin" Tab -->> "Task Scheduling" under Scheduling.

2. Click on the & icon to disable schedules. (or) Click on the # icon to enable
schedules that were disabled.

Edit "Scheduled Tasks"
To edit or modify a scheduled task

1. Click on the "Admin" Tab -->> "Task Scheduling" under Scheduling.
2. Click on the & icon against any scheduled task to edit schedule parameters.

3. Schedule Description, Schedule Type, Time Zone, Credentials and Data Sources
can be changed and updated by clicking on the "update" button.

(OR)
1. Click on "Admin" Tab -->> "Task Scheduling" under Scheduling.

2. Click on any Schedule Name to show the "Scheduled Gathering Task Details" for
the selected Schedule Name.

3. Click on "Edit" button to modify the Schedule parameters.

4. Schedule Description, Schedule Type, Time Zone, Credentials and Data Sources
can be changed and updated by clicking on the "update" button.

*’-? You cannot modify the Gathering Task, Schedule Name and Exchange
@\ Organization of any created schedule.

Delete "Scheduled Tasks"
To delete a scheduled task

1. Click on the "Admin" Tab -->> "Task Scheduling" under Scheduling.

2. Click on the ™ jcon against any scheduled task to delete the schedule.

you add an Exchange Organization in Exchange Reporter Plus) is required for the

[B?. The default Essential Data Gathering Task (which is created automatically when
basic functioning of the product. Hence, you cannot delete or disable this task.
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Scheduled Tasks History

Exchange Reporter Plus maintains a history of all scheduled tasks. This information can
be viewed from "Scheduled Tasks History".

To view the Scheduled Tasks History :
1. Click on the "Admin" Tab -->> "Task Scheduling" option under 'Scheduling”
2. Click on "Scheduled Task History".

This displays "Scheduled Gathering Tasks History".

Following are the fields available in the history of a scheduled task:

Fields Description
Schedule The name provided by the user.
Name

Task Name |The Data Gathering Task executed.

Start Time When the schedule was started.

End Time When the schedule was completed.

Duration The total time taken by the gathering task to complete its execution. This
depends on the volume of data that is to be gathered.

Execution Successful, Running or Failure of the listed scheduled gathering task is
Status shown.

The reason behind any failed schedule can be viewed by hovering over the
corresponding "Failure" Link.
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Log/Store Path

The Log/Store path option lets users edit the default "Message Tracking Log" and "Outlook
Web Access Info (11S) Log" Paths and information store paths.

Log Path

The Log Path information will be available only after the initial Essential Data Gathering
task is executed.

To edit the default log path :

Click on Admin -->> Log/Store Path (under Configurations)
Select the server for which the log path needs to be edited.

Edit both the "Message Tracking Log Path" and "OWA" Log Path in the text box.

P w N PR

Click on the Save icon.
This will update the Message Tracking and Outlook Web Access Info(11S) Log Paths.

The gatherings ("Message Tracking Logs" and "Outlook Web Access Info Logs (11S Logs)")
will use this new path.

The path should be in the following format:

e The Complete log folder path like "C:\Program Files\Microsoft\Exchange
Server\TransportRoles\Logs\MessageTracking"

The "User" whose credentials are entered for "Message Tracking Log Gatherings" and
"Outlook Web Access Info Log (11S Log) Gatherings" must have a minimum Read
permissions to read the log files.

Path info (available immediately after the initial Essential Data Gathering Task is

@7‘ Exchange Reporter Plus collects log data from the log path entered in it. The Log
executed), is collected from the Active Directory.

A log path change made by a user in MS Exchange is not automatically reflected
in the Active Directory. It is advisable to change that manually using the "Log
Path" configuration option.

A manual update of the log paths in the product is always given preference over
the log path information collected from Active Directory.

Information Store Path

From the "Information Store Path" option of Exchange Reporter Plus you can view the
database storage paths of Information Stores in your Exchange Organization and also edit
them.
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To edit the default Database Storage Path of an Information Store :

1.
2.

4.

Click on Admin -->> Log/Store Path (under Configurations)

Click on the [&icon against the "Database Storage Path" for the Information Store
you would like to edit.

This Pops out a modify screen which allows you to edit any or both "EDB Path" and
"STM Path" for respective databases of Exchange Information Stores.

Click on Update to modify the Database Storage Path for the Information Store.

The Databases of Information Stores in Exchange Server 2003 are stored in two different
formats (.edb and .stm formats), Exchange Reporter Plus lists both these storage paths in
different columns. The Databases of the Information Stores in Exchange Server 2007 and
2010 are stored in a single .edb format and is shown accordingly.

Y,
&

Exchange Reporter Plus collects the size of Information Store databases from the
database path displayed here. The database Path info (available immediately
after the initial Essential Data Gathering Task is executed), is collected from the
Active Directory.

A change made to a "Database Storage path of an Information Store" in MS
Exchange is not automatically reflected in the Active Directory. This implies that
the Information Store data is not up-to-date in the product. It is advisable to
change that manually using the "Information Store Path" configuration option.

A manual update of the "Database Storage paths for Information Stores" is
always given preference over the database path information collected from
Active Directory using Essential Data Gathering Task.
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OrganizationSettings

To gather data from your Exchange Organization you will need to add that Exchange
Organization in Exchange Reporter Plus.

If you give appropriate credentials during installation, the Exchange Organization will be
added automatically. You can manually add a new Exchange organization and delete,
modify or make an existing Exchange Organization as default from the "Organization
Settings" option.

e Adding a new Exchange Organization
 Modifying an existing Exchange Organization

e Deleting an Exchange Organization

e Making an Exchange Organization as default

Adding a new Exchange Organization:
To add a new Exchange Organization:

1. Click on the "Organization Settings" link under the "Admin" Tab
2. Click on "Add New Organization" under Configurations

3. Enter the "Global Catalog Server" name. [If your Exchange Server is within your
forest, Global Catalog Server name will be updated automatically.]

4. Provide "Credentials" and click on "Add" to add a New Exchange Organization.

[The credentials provided here will be used for a seamless data extraction from the
Exchange Servers. Ensure proper credentials are provided —Check the complete list of
privileges required for various data gatherings.]

Modifying an Exchange Organization:

To modify an Exchange Organization:
1. Click on the "Organization Settings" link under the "Admin" Tab

2. Click on the & icon against the Exchange Organization that is to be modified.
3. Modify the required fields.
4. Click on "Update"

Deleting an Exchange Organization:

To delete an Exchange Organization:
1. Click on the "Organization Settings" link under the "Admin" Tab

2. Click on ™icon against the Exchange Organization to be deleted.
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Making an Exchange Organization as Default:

Any Exchange Organizations can be made as default@ by clicking on the @icon
against the corresponding Exchange Organization.

By design, the product shows reports, home graphs and schedule creation options for
the Exchange Organization selected as default.
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Report Scheduling

You can schedule the automatic generation of reports by using the Report Scheduling

process.

1. Select “Schedule New Report” on top right corner of the page.

2. Specify the schedule name and description details.

3. The ‘Select Report’ section lets you to select a report category and a specific report
under the category.

4. The ‘Schedule Report Frequency’ can be used to specify the time span for report
generation.
Daily-This option is used for scheduling reports every day at a particular time.
Weekly-This option is for scheduling a report on a particular day of the week at a
specific time.
Monthly-This option is for scheduling a report on a specific day of each month at
the desired time.
Only Once-This option can be used to schedule a report only once on the specified
date and time.

5. The ‘Select Input’ section lets you to add and specify filters for the report.

6. You can select the storage path for specifying the location where you need the
reports to be stored.

7. You can also select the report format as CSV, PDF or XLS.

8. Enabling the ‘Email this Scheduled report’ mails the report to the email address

specified in the mail server settings.
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Configurations

The following configuration options under the "Admin" Tab, allows a user to configure
settings in Exchange Reporter Plus.

e Report Settings - Set default Time zone and Inactive period values using
this option. Internal Mail Domains can also be added.
« Product Settings - Configure Exchange Reporter Plus Connection Settings,

General Settings like logging level and Usage statistics gathering and the
theme of the product using this option.

e« Mail Server Settings — Configure the Mail server settings with its port

number. The default to and from email address can also be set for report
scheduling.
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Report Settings

The Report settings allows you to change the default Time Zone and the inactive
period. New internal domains can also be added.

Default Time Zone:

To Set or Change the Default Time Zone:
1. Click on Admin -->> Report Settings (Under Configurations)

2. Select the "Default Time Zone" between "GMT" and "Local"
3. Click on Save

GMT : Setting "GMT" as the Default Time Zone, will make the default time zone as GMT
at all instances, where you are required to choose a time zone.

Local: Setting "Local" as the Default Time Zone, will make the default time zone as
Local at all instances, where you are required to choose a time zone.

Inactive Period :

The Inactive Period value set here will be considered by Exchange Reporter Plus to
categorize inactive distribution groups and mailboxes.

To set a default Inactive Period:
1. Click on Admin -->> Report Settings (Under Configurations)

2. Enter the Period of inactivity of Mailboxes and Distribution Groups in the text box
provided.

3. Click on Save.

Internal Mail Domains:

The 'Internal Mail Domains' option lets user define internal mail domains based on which
traffic data will be gathered. With this option, new mail domains can be added, existing
ones can be modified or deleted.

To add a new internal mail domain:
1. Click on Admin -->> Report Settings (Under Configurations)

2. Enter the internal mail domain name. Use comma (,) to separate multiple domain
names.

3. Click on Add.

To edit the internal mail domain:

1. Hover the mouse over the domain name.

2. Click on %icon.

3. Edit the domain name and click on the save icon.
To delete the internal mail domain:

1. Hover the mouse over the domain name.

2. Click on *icon.
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Product Settings

The product settings allows you to change the Connection, General and Theme settings.
1) Connection Settings:

The connection settings allows you to change the "default port number”, that a
Server will run. By default, the Exchange Reporter Plus Server runs using the port
number <8181>.

To Change the Port Number:
1. Click on Admin -->> Product Settings. (Under Configurations)
2. Input a desired Port Number.
3. Click on Save.

Check in the Enable ssl port[https] to enable secure sockets layer and enter the number.

*’-? Changes in the Port Settings will reflect only on the restart of Exchange Reporter
@ Plus Server.

h !

2) General Settings:

The general settings can be used to set the logging level and enable or disable the Usage
Statistics Gathering.

Logging Level :

To Set or Change logging level for debugging information:
1. Click on Admin -->> Product Settings. (Under Configurations)
2. Select the "Logging Level" between "Normal" and "Debug".

Normal Mode: Setting the Logging Level as "Normal" will log a minimal
level of debugging information in the product log files.

Debug Mode: Setting the Logging Level as "Debug" will log a detailed
level of debugging information in the product log files.

Usage Statistics Gathering:

You can enable or disable the Usage Statistics Gathering option. This setting helps us in
improving Exchange Reporter Plus by keeping track of your usage pattern.

To enable or disable the setting:
1. Click on Admin -->> Product Settings. (Under Configurations)

2. Select the Enable or the Disable option.
3) Theme Settings:
The theme settings allows you to personalize the themes for Exchange Reporter Plus.

To select a theme:
1. Click on Admin -->> Product Settings. (Under Configurations)

2. Select the radio button against the "Blue Theme" or "Green Theme" and save. This

updates the selected theme.

/
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Mail Server Settings

You can configure the Exchange Mail Server settings using this option.
To specify the Mail Server settings:

1. Click on Admin -->> Mail Server. (Under Configurations)
2. Enter the Mail Server, Mail Port details in the text box.

3. If the mail server requires authentication, enable the option and provide the
credentials.

4. The default from and to address can be configured for Report scheduling.
5. Click on the save button for the settings to get stored.

6. The “Send Test Mail” option can be used for sending test mail to the specified
email id.
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Utilities

The following are the options under Utilities in Admin tab.

e User Management — Decide who can use Exchange Reporter Plus and
assign specific roles to them.

e License Management — You can manage your Exchange mailboxes by
using the license management settings.
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User Management

An administrator can select existing Active Directory users or create new users and
assign "Admin" or "Operator" roles to them.

Users provided Admin Roles can manage the configurations, data gathering
schedules and view Reports.

Users provided Operator roles can access the reports.

The User Management option allows you to:

Add Users

Modify the User Roles

Assign New Password to an Exchange Reporter Plus user
Delete Users

Enable / Disable Users

Add Users:

You can either add an existing "Active Directory User" or Create a New User with
"Exchange Reporter Plus authentication". The user created can be allowed to access the
product with the Roles assigned to him.

To add an Existing Active Directory User

P w b e

5.
6.

Click on Admin -->>User Management
Click on the "Add New User" link at the Top Right of the page.
Select the User Type as "Active Directory User".

Click on the "Select User" link against "User Name" to select the "Active Directory
User" from the Pop-Up. (The quick search option enhances the speed of your
search).

Select the "Role" to be assigned to the user.

Click on "Save".

This allows an existing "Active Directory User" to login into the product with his Active
Directory credentials and perform the Role assigned to him.

To Create a New "Exchange Reporter Plus User" to access the product

1.

© N o g bk w D

Click on Admin -->>User Management

Click on the "Add New User" link at the Top Right of the page.

Select the User Type as "Exchange Reporter Plus User" from the Drop Down
Enter a User Name

Enter a Password

Confirm the Password.

Select the "Role" to be assigned to the user.

Click on "Save".
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This creates a new user who can access the product with a corresponding "Role"
assigned to him. This user can login into the product using "Exchange Reporter Plus
authentication” with the "Password" given during user creation.

Modify the User Roles:

This will modify the Role assigned to a selected user. You cannot modify the role of the
default "admin" user.

1. Click on Admin -->>User Management (This lists all the Users who can access the
product)

2. To modify the User Role click on the & icon.
3. Select a different Role from Drop Down. ("Admin" or "operator")

4. Click on "Save".

Assign a New Password to an Exchange Reporter Plus User

This action is applicable only for users who use an Exchange Reporter Plus
authentication.

1. Click on Admin -->>User Management (This lists all the Users who can access the
product)

2. Click on "Assign New" against the password to be changed user.
3. Enter the New Password

4. Confirm the Password

5. Click on Save.

This will assign a new password for the user. You can also change the default "admin"
user password with this option.

Delete Users:

To delete a user:
1. Click on Admin -->>User Management (This lists all the Users who can access the
product)
2. To delete a User click on the ™ icon against the user to be deleted.

3. Click on OK.
You cannot delete the default "Admin" user.

Enable / Disable Users:

To enable / disable any user who accesses the product.
1. Click on Admin -->>User Management (This lists all the Users who can access the
product)

2. To disable any user click on @ icon. (or) To enable any disabled user click on /)
icon.
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LicenseManagement

ManageEngine Exchange Reporter Plus license is based on the number of mailboxes. You
need to buy a license corresponding to the number of mailboxes in your Exchange
Organization. However, if you require data to be collected from selected mailboxes present
in servers, you can selectively manage those mailboxes using this option.

Data is gathered for reporting only from managed mailboxes.

To Manage Exchange Mailboxes :

e Click on "License Management" under the "Admin" Tab.
e For each Exchange Server, click on the mailbox count and check the Mailboxes you
want to manage.
e Click on the ok button.
To manage all mailboxes under a particular server in an Exchange Organization, hover the
mouse over the mailbox count and select the "Manage All" option that appears.

To Un-manage Exchange Mailboxes :

e Click on "License Management" under the "Admin" Tab.
e Under each Exchange Server, click on the mailbox count and uncheck the
Mailboxes you want to unmanage.
e Click on the ok button.
To unmanage all mailboxes under a particular server in an Exchange Organization, hover
the mouse over the mailbox count and select the "Unmanage All" option that appears.
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Troubleshooting

Essential Data Gathering [or] Distribution List Membership Gathering Tasks

Unable to bind root DSE

Causes:
Not able to Ping the configured GC from the installation machine.
Firewall has been enabled, and port 389 is closed.
Unknown Username or Bad Password entered in the organization
settings page.
Global Catalog Server(GC) configured in the organization settings
page might be down.
Resolution:
e Confirm if you are able to ping the Global Catalog Server from the
machine where Exchange Reporter is installed.
e Exchange Reporter Plus uses port 389 for LDAP connection. If firewall
is enabled, ensure that the port 389 is added to the exception list.
e Verify the correctness of Username and Password entered in the
organization settings page.

Mailbox Account Properties [or] Mailbox Content [or] Public Folder Properties [or] Public
Folder Content Gathering Tasks

MAPI is required for this report. Please install MAPI

Cause:
e MAPI required for this task is not installed.

Resolution:
e MAPI can be installed using any one of the following three MAPI
providers - 'Microsoft Outlook 2003 and 2007', ‘MAPI Download' or
'Exchange System Manager 2003 SP2'.
Note:
¢ Only '"MAPI Download' is supported for Exchange 2010 environments.
e 64-bit Microsoft Outlook is not supported by Exchange Reporter Plus.
e Ensure that 'MAPI Download' and 'Microsoft Outlook' are not installed on the
same machine where Exchange Reporter Plus is installed.

Please set '"Microsoft Outlook' as default mail client

Cause:
e When 'Microsoft Outlook® is used as a MAPI provider, it must also be set as the

default mail client.
Resolution:

¢ Set 'Microsoft Outlook' as the default mail client. To set Microsoft
Outlook as the default mail client, Open Internet Explorer -->>
Click on Tools -->> Internet Options -->=> Click 'Programs' tab in
the Emaiil list, Click ‘Microsoft Office Outlook' -->> Click 'OK"


http://www.microsoft.com/downloads/details.aspx?FamilyID=E17E7F31-079A-43A9-BFF2-0A110307611E&displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyID=E17E7F31-079A-43A9-BFF2-0A110307611E&displaylang=en
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Unknown User name or bad password provided in the 'Organization Settings'
page. Please enter valid credentials

Cause:
e User Credentials provided in the 'Organization Settings / Task scheduling' page
or while configuring 'Exchange Reporter Plus Service' might be wrong.

Resolution:
o Verify the correctness of the user name and password entered in the above
locations. The username should be provided as <DomainName\UserName=>

The user provided in the 'Organization Settings' page is not a member of view
only administrative group

Cause:
e The User provided in the '‘Organization Settings / Task scheduling’' page or while
configuring 'Exchange Reporter Plus Service' is not a member of a desired
privileged group.

Resolution:
o Verify if the user provided in the 'Organization Settings' page is a member of one of
the following Groups
e 'Exchange View only Administrator Group', if Exchange
Server 2003 User (or)
e 'Exchange Organizational Administrator Group’, if
Exchange Server 2007 User (or)
e 'Organizational management Group’, if Exchange 2010
User.
When the Product is installed as a Service, the configured Service Account must
abide by the defined criteria. The configured service account must be a local system
administrator.
The user credential should have "Send As" and "Receive As" permissions on
Organization Mailboxes.

The mailbox user provided in the 'Organization Settings' page is hidden from the
Global Address List

Cause:

e User Credentials provided in the 'Organization Settings / Task scheduling' page or
while configuring 'Exchange Reporter Plus Service' might be wrong. The mailbox
user provided in the 'Organization Settings/Task Scheduling' page or while
configuring the 'Exchange Reporter Plus Service' is hidden from the Global Address
List.

Resolution:
o Verify if the user whose credentials entered in the 'Organization Settings' page, has
a valid MAILBOX which is not hidden from the GAL (Global Address List).

To unhide the user from Global Address List,
e Open user properties from 'Active Directory Users and
Computers’, navigate to 'Exchange Advanced' Tab and
uncheck 'Hide from Exchange Address List'.
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'"Access denied’ to Organization mailboxes for the user credentials provided in
the 'Organization Settings' page.

Cause:
e Insufficient Privileges to access Organization Mailbox for the user credentials
provided. (The user credentials could be provided under the 'Organization Settings /
Task scheduling' page or while configuring 'Exchange Reporter Plus Service").

Resolution:
o Verify if the user whose credentials entered in the 'Organization Settings' page
1. Has a valid MAILBOX which is not hidden from the GAL (Global
Address List).
2. Has logged-on to his/her designated Mailbox at least once.
3. Has "Send As" and "Receive As" permissions on the Organization
Mailboxes.
4. Is a member of one of the following Groups
e 'Exchange View only Administrator Group' if
Exchange Server 2003 User (or)
e 'Exchange Organizational Administrator Group' if
Exchange Server 2007 User (or)
¢ 'Organizational management Group' if Exchange
2010 User
5. Verify if the 'Exchange Server' under consideration is accessible from
the machine where Exchange Reporter Plus is installed.

Unable to create MAPI profile. User credential provided in the 'Organization
Settings' page does not have a valid mailbox.

Cause:
e User credential provided in the does not have a valid mailbox. The user credentials
could be provided under the 'Organization Settings / Task scheduling' page or while
configuring 'Exchange Reporter Plus Service'.

Resolution:
o Verify if the user whose credentials entered 'Organization Settings' page,

e Has a valid MAILBOX that is not hidden from the GAL
(Global Address List) and

e Has logged-on to his/her designated Mailbox at least
once.

e Has "Send As" and "Receive As" permissions on
Organization Mailboxes.

Unable to collect Mailbox Information using the credentials provided in the
'Organization Settings' page.

Cause:
e Unable to logon to MAPI Client required for collecting Mailbox Information with the
credentials provided in any of the folowing locations - '‘Organization Settings / Task
Scheduling' page or while configuring 'Exchange Reporter Plus Service'.



Q ManageEngine Exchange Reporter Plus :: Help Documentation =
. 4

Resolution:
e Verify the correctness of Username and Password entered in the organization
settings page.
e Verify if the User credentials provided,
1. Has a live accessible mailbox and
2. Has Send As" and "Receive As" permissions on the Organization mailboxes.
3. Is a member of one of the following Groups
= ‘'Exchange View only Administrator Group'
if Exchange Server 2003 User (or)
= 'Exchange Organizational Administrator
Group' if Exchange Server 2007 User (or)
= ‘'Organizational management Group' if
Exchange 2010 User

Mailbox store is unavailable or the user credential provided in the 'Organization
Settings' page has no access to the store

Cause:

e Exchange Reporter Plus is unable to communicate with the Mailbox Information
Store of the specified Exchange Server for the credentials provided. The user
credentials could be provided under the 'Organization Settings / Task scheduling’
page or while configuring 'Exchange Reporter Plus Service'.

Resolution:
e Ensure that the Mailbox Private Store of the specified Exchange Server is mounted.
Also ensure that a privileged user credentials are provided in the Organization
Settings page.

Problem in MAPI Installation. Please uninstall and re-install MAPI

Cause:
e An unexpected problem might have occurred while MAPI Installation.

Resolution:
e Sometimes MAPI installation might unexpectedly fail. Please uninstall and reinstall
MAPI and restart Exchange Reporter Plus for the changes to take effect.

Schedule run Successful! Unmanaged Servers exempted from Data Gathering

Cause:
e The Scheduled Task includes one or more servers that are "unmanaged".

Resolution:
¢ Remove Unmanaged Servers from Scheduled Task Data Sources or ensure that the
server has at least one managed mailbox.
Note:

e Exchange Reporter Plus is licensed based on number of mailboxes, for a Server to
be managed it should include at least one licensed mailbox in it. You can manage
mailbox license from Admin -->>License Management option.
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Schedule run Successful! Unmanaged Mailboxes exempted from Data Gathering

Cause:
e The Scheduled Task includes one or more mailboxes that are "unmanaged".

Resolution:
e Ensure that only the managed mailboxes are considered for the scheduled task.
Note:
e Exchange Reporter Plus is licensed based on number of mailboxes. You can manage
mailbox license from Admin -->>License Management option.

Message Tracking Logs [or] OWA Logs Gathering Tasks

Network Path not found

The given network path is no longer accessible
The specified network name is no longer available
No network provider accepted the given network path

Cause:
e Exchange Reporter Plus is not able to access the Log Path configured under
'‘Log/Store Path' settings page.

Resolution:

e Check if the 'Log/Store Path' configured under 'Log/Store Path' settings page is
correct.
e Ensure that you are able to access the admin$ of the specified Server.
o From the installation machine, select Start --> Run and type \\<Server
Name=>\admin$.
o If you get the same error, enable Remote Administration Exception for the
Server as below:
= From the Server, select 'Start’' --> 'Run’ and type 'gpedit.msc' and hit
‘enter’
= Expand the Administrative Templates -> Network Connections ->
Windows Firewall
= Click the Domain Profile and double click the Windows Firewall : Allow
remote administration exception
= Select Enabled and click OK
e Ensure that you are able to ping the specified Server by FQDN

From the installation machine, open a command prompt and type ping
<FQDN of the Server>. You must be able to ping the Server using its Fully
Qualified Domain Name (eg. hostname.domainname.com).

Given user has been denied to use the admin share

Cause:
e Unable to access the configured Exchange Server log files location with user
credentials provided in the Organization Settings page.
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Resolution:
e Check if you are able to 'ping’' the admin share of the Specified Server
from the installation machine using the user credentials provided in
Organization Settings page.

» From the installation machine Click on Start --> Run --> Type
\\\<Servername=>\c$'

e Check if the Log Path entered under 'Log / Store Path' in Exchange
Reporter Plus is of the following format.

» The Traffic Log Path Format for Windows 2003 Server would be like :
'C:\Program Files\Exchsrvr\<servename.log>' and for Windows 2007 /
2010 would be like 'C:\Program Files\Microsoft\Exchange
Server\V14\Transport Roles\Logs\Message Tracking'

» The OWA Log Path Format for Windows 2003 / 2007 Server would be like :
'C:\WINDOWS\system32\LogFiles\W3SVC1' and for Windows 2010 would
be like 'C:\inetpub\logs\LogFiles\W3SVC1’

Invalid Log Path

Cause:
e Exchange Reporter Plus collects log path info from the Active Directory. A log path
change made by a user in MS Exchange is not automatically reflected in the Active
Directory.

Resolution:
o Verify the log path configured in Exchange Reporter Plus (Admin -->>Log / Store
path). If any of the Servers log path is not correct, update them manually.

e To modify the 'Log Path' for the Specified Server:
0 Go to the 'Admin’ tab in the product

Click on 'Log / Store Path’
Modify the 'Traffic Log Path'
Modify the "'OWA (11S) Log Path'
Click on 'Save'.

PONPE

No log files found

Cause:

e Message Tracking Logging or Outlook Web Access logs might not have been
enabled in Exchange Server.

Resolution:
e Enable 'Message Tracking logs' in Exchange Server.

To enable Message Tracking Logs for Exchange Server 2003

Follow the below steps to enable ‘Message Tracking Logs' for Exchange Server 2003

1. Click on Start -->All Programs -->> Microsoft Exchange -->>System Manager
2. From the 'Exchange System Manager' --> Right click against the Server and Click
on 'properties’
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3. From the 'Properties' dialog, Click on 'General' Tab, provide a check against '‘Enable
Message Tracking' and click on 'OK' button.

EMP-EX03 Properties [ 2] |

Diagrnostice Logaing i Public Faolder Beferalz I Dretailz l Directomy Access
REC-HTTF I Folicies I Securty I Full-Test Indexing I b onitoring
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[ TIhisis a front-end server

Clientz connect here, and cammands are relayed to a back-end
FEIVEL

[ Automatically zend fatal service error information to Microsoft,

k. I Cancel Apply Help

To Enable Message Tracking Logs for Exchange Server 2007/ 2010

'Message Tracking Logs' for Exchange Server 2007/2010 must be enabled from the
Management Console of the respective servers.

1. Click on Start --=>All Programs -->> Microsoft Exchange Server 2007-->>Exchange
Management Console

2. From the 'Exchange Management Console'-->Click on 'Hub Transport'--> Right click
against the Server and Click on 'properties’

3. From the 'Properties’ dialog, Click on 'Log Settings' Tab, provide a check against
‘Enable Message Tracking' and click on 'OK" button.
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EMP-EX07F Properties |
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e Enable Outlook Web Access Logs in Exchange Server

To enable Outlook Web Access Logs for 1IS 6.0

Follow the below steps to enable logging for 1IS 6.0

1. On the Taskbar, click Start --> Control Panel--> Administrative Tools--> Internet
Information Services (11S) Manager.

2. Right Click on Websites--> Default Web Site and select Properties.

3. Click Properties button under Enable Logging section

To Enable Outlook Web Access Logs for 1IS 7.0

For 11S 7 follow the steps below to enable Cookie.

1. On the Taskbar, click Start --=> Control Panel --=> Administrative Tools --> Internet
Information Services (11S) Manager.

2. Right Click on Sites --> Default Web Site and select Properties

3. On the Logging page, in the Actions pane, click Enable to enable logging or click
Disable to disable logging.

4. In Features View, double-click Logging.

OWA Requirements needs to be configured.

Cause:
e csCookie field might not have been enabled in OWA.

Resolution:
e Enable csCookie with the following steps.
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Follow the below steps to enable csCookie logging for IIS 6.0

Go to Run -> Type ‘inetmgr' -> Expand Server name.

Expand "Web Site" -> Go to Properties of "Default Web Site".

Enable Logging

Click on Properties --> Go to "Advanced" tab -> Provide a check against "Cookie (
cs(Cookie)) and click on OK.

PoOME

For 11S 7 follow the steps below to enable csCookie logging.

Go to Run --> Type 'inetmgr' -->Expand Server name

Expand 'Sites' --> Click on 'Default Web Site'

Open 'Logging’.

Enable logging by clicking on 'Enable’ from Actions column.

Click on "Select Fields" under Log file and Enable Cookie ( cs(Cookie)).
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Schedule run Successful! Unmanaged Servers exempted from Data Gathering

Cause:
e The Scheduled Task includes one or more servers that are "unmanaged".

Resolution:
e Remove Unmanaged Servers from Scheduled Task Data Sources or ensure that the

server has at least one managed mailbox.

Note:

o Exchange Reporter Plus is licensed based on number of mailboxes, for a Server to
be managed it should include at least one licensed mailbox in it. You can manage
mailbox license from Admin -->>License Management option.

Mailbox Permission Gathering Task

Please ensure Exchange Management Shell(EMS) is installed in the machine
where the product is installed

Cause:
e For Exchange Server 2007 and 2010 environments, Exchange Management Shell is

needed for gathering Mailbox Permission Reports
Resolution:
¢ Install Exchange Management Shell in the same machine where Exchange Reporter
Plus is installed.

Exchange system manager (ESM) is needed for this schedule. ESM is compatible
only with 32 bit machines. Please move the product to a 32 bit machine on which
ESM can be installed

Cause:
e Exchange System Manager(ESM) is required for Mailbox Permission gathering in
Exchange Server 2003 environments. 64 bit servers cannot accommodate Exchange

System Manager (ESM).

Resolution:
e Uninstall the product and re-install it on a 32 bit machine where Exchange System

Manager (ESM) is installed.
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Schedule run Successful! Unmanaged Servers exempted from Data Gathering

Cause:
e The Scheduled Task includes one or more servers that are "unmanaged".

Resolution:
¢ Remove Unmanaged Servers from Scheduled Task Data Sources or ensure that the
server has at least one managed mailbox.
Note:

e Exchange Reporter Plus is licensed based on number of mailboxes, for a Server to
be managed it should include at least one licensed mailbox in it. You can manage
mailbox license from Admin -->>License Management option.
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Sending Support Information

In-order to analyze issues or other challenges faced by evaluators / customers the
Exchange Reporter Plus product team might request for product logs (Support
Information). This will provide the team a clear understanding on the problem /
challenge reported.

The creation of the support information is either done with the help of Automatic process
or can also be done manually.

How to automatically create and send information:

1. Click on Support Tab -->> Support Info -->>Create log : Auto

2. This will automatically create a support info file and if there is an Internet
connection enabled will also be automatically sent to Exchange Reporter Plus
team.

3. In machines where internet connection is disabled, Once the support info file is
created a Pop-up will prompt you to save the file on the local machine.

4. Attach the saved zip file and mail it to support@exchangereporterplus.com,

5. Alternatively if the file size is large you can upload the saved file to our server by
following the below steps.

Type : http://bonitas.zohocorp.com/upload/index.jsp on a web browser.
Select "Exchange Reporter Plus" from the send to option.
Provide your Email address.

1

2

3

4. Add a comment.
5. Attach the saved support info file from the stored location.
6

Click on Upload.

- *’-? The creation of support info using the Auto option might take a few minutes
@ depending on the size of the logs, in these you can create support info manually.

How to manually create and send Information:

Go to Exchange Reporter Plus installation folder
Open the bin folder

Double click on "createSupportinfo.bat” file.

A w0 DhdoE

Go back to the installation folder and open logs\support folder to find
ExchangeReporterPlus_Logs.zip file.

@

Attach the zip file and mail it to support@exchangereporterplus.com

6. Alternatively if the file size is large you can upload the saved file to our server by
following the below steps.


mailto:support@exchangereporterplus.com
http://bonitas.zohocorp.com/upload/index.jsp
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Type : http://bonitas.zohocorp.com/upload/index.jsp on a web browser
Select "Exchange Reporter Plus" from the send to option.

Provide your Email address.

1.

2

3

4. Add a comment.
5. Attach the saved support info file from the stored location.
6

Click on Upload.
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